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Getting help and support Related documentation

Related documentation

The following manuals are available as part of the TekExpress SFP+ QSFP+ Tx Compliance and Debug
Solution documentation set.

Table 1: Product documentation

Item Purpose Location
Online Help In-depth operation and Ul help

PDF of the Online Help In-depth operation and Ul help

E: + W\;\/-\T\).Tektronix.com

See also

B_Technical Support

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 1



Getting help and support Conventions used in help

Conventions used in help

Online Help uses the following conventions:
B  The term “DUT” is an abbreviation for Device Under Test.

B The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

2 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Getting help and support Technical support

Technical support

Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope. Contact Tektronix through mail,
telephone, or the Web site. See Contacting Tektronix for more information.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General information

®  All instrument model numbers

B Hardware options, if any

®m  Probes used

B Your name, company, mailing address, phone number, FAX number

B Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information

B Software version number

m  Description of the problem such that technical support can duplicate the problem
B [fpossible, save the setup files for all the instruments used and the application

B [fpossible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status
messages text file

B [fpossible, save the waveform on which you are performing the measurement as a .wfm file

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 3



Getting help and support Technical support
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Getting started Technical support
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Getting started Tektronix oscilloscope compatibility

Tektronix oscilloscope compatibility

The TekExpress SFP+ QSFP+ Tx application runs on the following Tektronix oscilloscopes:

DPO/DSA/MS071604C and DPO/DSA/MSO72004C Series Digital Oscilloscopes
DPO/DSA72504D and DPO/DSA73304D Series Digital Oscilloscopes

DPO/MS072304DX, DPO/MS0O72504DX, and DPO/MSO73304DX Series Digital Oscilloscopes
DPO70000SX Series Digital Oscilloscopes

See also

B_Minimum System Requirements

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Getting started Minimum system requirements

Minimum system requirements

The following table shows the minimum system requirements needed for an oscilloscope to run
TekExpress.

Table 2: System requirements

Processor Same as the oscilloscope
Operating System Same as the oscilloscope (Windows 7, 64-bit only)
Memory Same as the oscilloscope
Hard Disk Same as the oscilloscope
Display Same as the oscilloscope !
Firmware TekScope 10.3.3 for non-SX series digital oscilloscopes
TekScope 10.3.0 for SX series digital oscilloscopes
Software B DPOJET, Jitter and Eye Diagram Analysis Tool, version 10.0.0.35 or later
(64-bit)

B MathWorks MATLAB Runtime 8.02 (Windows 7)

= |ronPython 2.7.3

B PyVisa 1.0.0.25

®  Microsoft .NET 4.0 Framework

B Microsoft Internet Explorer 6.0 SP1 or later

m  Microsoft Photo Editor 3.0 or equivalent software for viewing image files

B Adobe Reader 7.0 or equivalent software for viewing portable document
format (PDF) files

Other Devices B Microsoft compatible mouse or compatible pointing device

B Four USB ports (two USB ports minimum)

® PCI-GPIB or equivalent interface for instrument connectivity 3

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, a sampling oscilloscope), it is recommended
that you connect a secondary monitor, which must be enabled before launching the application.

2 MatLab Runtime Compiler is required for performing the Host Output TWDPC test. This test is purchase option SFP-WDP.

3 If TekExpress is installed on a Tektronix oscilloscope, TekExpress will use the virtual GPIB port for communicating with oscilloscope applications. If
external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, make sure that the Talker Listener
utility is enabled in the GPIB menu of the DPO/DSA oscilloscope. For ease of use, connect to an external (secondary) monitor.

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 7



Getting started Minimum system requirements

User access control

On Windows 7 instruments set User Access Control settings to Never Notify. To set User Access Control
Settings, go to Control Panel > User Accounts > Change User Access control Settings and set it to Never
Notify as shown in the image.

) User Account Control Settings ol =
Choose when to be notified about changes to your computer
User Account Cantrol helps prevent patentially harmful pragrams from making changes to your computer.
Tell me more about User Account Control settingd
Always notify
-1 - Never notify me when:
®  Programs try to install software or make changes te
my computer
- - * [make changes to Windows settings
@ Notrecommended. Choose this enly if you need to
use programs that are not certified for Windows 7
- because they do not support User Account Cantral.
Never notify
e 4

B__Compatibility
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Getting started Install the software

Install the software

The software can be installed on any compatible instrument running Windows 7 (64-bit). See Minimum
System Requirements for details.

1. Close all applications.

2. Go to the www.tek.com Web site and search for SFP+ QSFP+ Tx to locate the installation file.
Download the file SFP+QSFP+TxWebinstaller.exe.

3. Double-click the executable file to extract the installation files.
After extraction, the installer launches and the software automatically installs in the following location:

= Windows 7 location: C:\Program Files\Tektronix\TekExpress\TekExpress SFP+
QSFP+ TX

See also

B_Minimum System Requirements
B Compatibilit

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 9



Getting started Activate the license

Activate the license

10

Activate the license using the Option Installation wizard on the oscilloscope. Instructions for using the
Options Installation window to activate licenses for installed applications is provided in the oscilloscope
online Help:

1. From the oscilloscope menu bar, click Utilities > Option Installation.
The TekScope Option Installation wizard opens.

2. Press the F1 key on the oscilloscope keyboard to open the Option Installation help topic. Follow the
directions in the topic to activate the license.

Contact Tektronix for a floating license or fixed license for this TekExpress application.

See also

B View Version and License Information
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Getting started View version and license information

View version and license information

Use the following instructions to view version information for the application and for the application
modules such as the Programmatic Interface and the Programmatic Interface Client.

To view version information:
1. From the Options menu, select About TekExpress.

2. Click the View Version Details link to check the version numbers of the installed test suites.

Version Details

[=1- Autamation Framewark

TekExpress: 3.0.0.16_Rews,

- Instrument Bench : 1.0.0.0

- Ernail Companent - 1.4.6.21703

- Programmatic Interface ; 1.4.6.28643

i Programmatic Interface Client : 1.4.6.21703
B Automated Salution

- BSFP* Ty
- Host:3.0.0.29
o Module - 3.0.0.29

= 5FP+ Ta
- Host:3.0.0.29
o Module - 3.0.0.29

To view license information:
1. From the oscilloscope Help menu, select About TekScope.
The Options section in the dialog box displays a list of installed options, including SFP+ QSFP+ Tx.

2. To view the Option key, look in the Option installation key section.

See also

m__ Activate the License

B_ Options Menu

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution "



Getting started SFP+ QSFP+ Tx application overview

SFP+ QSFP+ Tx application overview

12

NOTE. The skew between Data+ and Data- in the signal path from the DUT to the oscilloscope will be
computed and compensated before running the measurements.

TekExpress is the Tektronix Test Automation Framework, developed to support your current and future
test automation needs. TekExpress uses a highly modular architecture that lets you deploy automated test
solutions for various standards in a relatively short time.

Key features

TekExpress SFP+ QSFP+ Tx has the following key features:

Allows conformance testing to the latest Compliance Test Specification (CTS)

Reliable Testing:

= Conformance to SFP+ and QSFP+ interconnect module electrical testing ensures reliable results
- SFP+ QSFP+ Tx is SFP+ and QSFP+ compliance software

= Enables execution of the physical-layer (PHY), electrical tests, and SFP+/QSFP+ based electrical
measurements

Automated testing:

- Minimizes user intervention when conducting time-consuming testing

- Reduces the time required to conduct testing

Selective testing:

= Performs fully-automated testing for transmitter measurements

= Allows you to select individual tests or test groups in the tree-structure

= Avoids repeated testing through accurate and reliable results from a single run
Quick testing:

= One-button selection of multiple tests ensures faster testing

= Test margins and statistical information aid analysis to find answers quickly

= One-button .mht report saves time

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Getting started SFP+ QSFP+ Tx application overview

®  Complete Solution:

= Wide range of tests for SFP+/QSFP+ Host devices and SFP+/QSFP+ Module devices enables
complete validation

= Complete compliance solution with an elaborate test fixture and signal sources support for SMA
cable-based solution provides cost-effective way to perform compliance testing

= User defined mode supports PRBS7, PRBS11, PRBS15, PRBS20 & PRBS23 in addition to
patterns supported in Compliance mode including PRBS9, PRBS31 and 8180

B Customize the setup:
= Modify the test setup according to the DUT configuration.
= Run test measurements with different record lengths.
- Run test measurements with more than one signal.
B Detailed test reporting:
- Provides a Pass/Fail summary table
= Provides margin details on each test
= Provides a consolidated report for all tests

- Provides additional information such as skew, and signal type selected for each measurement

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 13



Getting started

Application directories and usage

Application directories and usage

14

The application directory and associated files are organized as follows:

. ACP

. Bin

. Compliance Suites
. Documents

. Examples

) ICP

. Images

. Lib

. Report Generator
) SCP

| Tools

The following table lists the default directory names and their usage.

Table 3: Application directories and usage

Directory names

Usage

InstallDinTekExpress\TekExpress SFP-Tx

Contains the application and associated files

TekExpress SFP+ QSFP+ Tx\ACP

Contains instrument and SFP+ QSFP+ Tx application-specific
interface libraries

TekExpress SFP+ QSFP+ Tx\Bin

Contains miscellaneous SFP+ QSFP+ Tx application libraries

TekExpress SFP+ QSFP+ Tx\Compliance Suites

Contains compliance-specific files

TekExpress SFP+ QSFP+ Tx\Documents

Contains the technical documentation for the SFP+ QSFP+ Tx
application

TekExpress SFP+ QSFP+ Tx\Examples

Contains various support files

TekExpress SFP+ QSFP+ Tx\ICP

Contains instrument and SFP+ QSFP+ Tx application-specific
interface libraries

TekExpress SFP+ QSFP+ Tx\Images

Contains various Image files

TekExpress SFP+ QSFP+ Tx\Lib

Contains utility files specific to the SFP+ QSFP+ Tx application

TekExpress SFP+ QSFP+ Tx\Report Generator

Contains style sheets for report generation

TekExpress SFP+ QSFP+ TX\SCP

Contains instrument and SFP+ QSFP+ Tx application-specific
interface libraries

TekExpress SFP+ QSFP+ Tx\Tools

Contains instrument and SFP+ QSFP+ Tx application-specific files

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Getting started Application directories and usage

See also

B View Test-Related Files

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 15



Getting started File name extensions

File name extensions

16

The TekExpress SFP+ QSFP+ Tx application uses the following file name extensions:

File name extension Description

TekX Session files are saved in this format but the extensions may not be
displayed.

-py The test sequence file

xml The encrypted XML file that contains the test-specific configuration
information
The log file extension is also xml.

wfm The test waveform file

.mht Test result reports are saved in this format by default. Test reports can

also be saved in HTML format.

See also

B View Test-Related Files

B Application Directories and Usage
B Before You Click Start
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Operating basics Start the application

Start the application

The first time you open the application after installation, you are required to enter a license key. The
application also checks for a file called Resources.xm1 located in the My TekExpress folder. If this file
is not found, the application performs instrument discovery before launching. The Resources.xm]1 file
contains information regarding instruments that are available on your network.

NOTE. Contact Tektronix for floating license or fixed license of TekExpress SFP+ QSFP+ Tx.

To run the SFP+ QSFP+ Tx application, do one of the following:
®  From the TekScope Analyze menu, select Analyze > TekExpress SFP+ QSFP+ Tx.
B Double-click any saved session file.

While running the application, switch between the oscilloscope screen and SFP+ QSFP+ Tx by clicking
the desired window or by using the Alt+Tab key combination. To keep the application window on top,
select Keep On Top from the Options menu.

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the
previously unsaved session.

See also

m_ Activate the License

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution 17



Operating basics Exit the application

Exit the application

Use the following method to exit the application:

NOTE. Using other methods to exit the application results in abnormal termination of the application.

1. Click on the application title bar.

2. Do one of the following:

= Ifyou have an unsaved session or test setup open, you will be asked to save it before exiting. To
save it, click Yes. Otherwise click No. The application closes.

= A message box appears asking if you really want to exit TekExpress. To exit, click Yes.

18 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Operating basics

Application controls

Application controls

Table 4: Application controls descriptions

Item Description
Options menu Opens the Options menu for access to global controls
Panels Visual frames with sets of related options

Command buttons

Buttons that initiate an immediate action such as the Start,
Stop, Pause, Continue, and Clear command buttons

Start button

Use the Start button to continuously acquire and accumulate
measurements. If prior acquired measurements have not
been cleared, the new measurements are added to the
existing set.

Stop button

Stop

Use the Stop button to abort the test.

Pause \ Continue button

Pause Continue

oy

Use the Pause button to temporarily interrupt the current
acquisition. When a test is paused, the button name
changes to “Continue.”

Clear button

Clear

Use the Clear button to clear all existing measurement
results. Adding or deleting a measurement, or changing a
configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation
of measurement statistics or sets of statistics that are not
coherent. This button is available only on the Results panel.

Application window move icon

Place the cursor over the three-dot pattern in the upper left
corner of the application window. When the cursor changes
to a hand, drag the window to the desired location.

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution
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Operating basics

Options menu

Options menu

20

The Options menu is located in the upper right corner of the application.

The Options menu has the following selections:

Menu Function

Default Test Setup Opens an untitled test setup with defaults selected
Open Test Setup Opens a saved test setup

Save Test Setup Saves the current test setup selections

Save Test Setup As Creates a new test setup based on an existing one

Open Recent

Displays a menu of recently opened test setups to select from

Instrument Control Settings

Shows the list of instruments connected to the test setup and allows
you to locate and refresh connections to those instruments

Keep On Top

Keeps the TekExpress SFP+ QSFP+ Tx application on top of other
open windows on the desktop

Email Settings

Use to configure email options for test run and results notifications

Deskew Use to deskew channels
Help Displays TekExpress Help
About TekExpress B Displays application details such as software name, version

number, and copyright

B Provides access to license information for your SFP+ QSFP+ Tx
installation

B Provides a link to the Tektronix Web site

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Operating basics

Options menu

Options menu

Default Test Setup

Open Test Setup

Save Test Setup

Save Test Setup As

Open Recent b

Instrument Control Settings
Keep On Top

Email Settings

Deskew...

Help

About TekExpress

See also

®_ Application Controls

TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution
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Operating basics Email settings

Email settings

Use the Email Settings utility to configure email notifications if you want to receive notifications when a
test completes, produces an error, or fails. Select the type of test session information to include in the
notification, such as test reports and test logs, the email message format, and the email message size limit.

NOTE. Recipient email address, sender s address, and SMTP Server are mandatory fields.

See also

E_Options Menu

m_Select Test Notification Preferences

22 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Operating basics Instrument control settings

Instrument control settings

The Instrument Control Settings dialog box shows the list of resources found on different connections. It
serves two purposes:

®  Discovers the connected instruments

B Confirms the instrument connection setup

_TekExpress Instrument Control Se

—
October 05. 2011 13:43:41 f "

Use the Instrument Control Settings feature to search for connected instruments and view instrument
connection details. Connected instruments displayed here can be selected for use under Global Settings in
the test configuration section. See step 2 of Configure Tests for details.

See also

B_ Options Menu
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Operating basics About panels

About panels

TekExpress SFP+ QSFP+ Tx has the following main panels:

Table 5: Application panels

Panel Name Purpose
Setup The Setup panel allows you to configure the test setup. Use this panel to:

m  Select device parameters.

B Select the test(s).

m  Select acquisitions parameters for selected tests.

B Configure the selected tests.

B Select test notification preferences.

Status View the acquisition and analysis status of the selected tests, and view test logs.
Results View a summary of test results and select result viewing preferences.
Reports Browse for reports, save reports, specify report naming conventions, select content to include

(such as summary information, detailed information, user comments, plot images, setup
configuration), and select other report viewing options.

See also

B__Application Controls
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Setup panel

The Setup panel has numbered tabs to guide you through the test setup process:

1 -DUT

2 — Test Selection
3 — Acquisitions
4 — Configuration
5 — Preferences

By default, only the DUT, Test Selection, Acquisitions, and Preferences tabs are displayed. The
Configuration tab is only available if you select the Advanced View option in the DUT tab. Otherwise,
configuration settings for tests are available from the Configure button on the Test Selection tab.

Options selected in a preceding tab affect options available in the next tab down. However, you can switch
between the tabs in any order if you need to modify test parameters. For more information on using the
Setup panel, see Test Setup Overview.

By default, QSFP+ Tx is the selected standard in the DUT tab. Use the Standard drop-down box to
select the SFP+ Tx standard.
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Setup panel

26

When you finish making selections in a tab and move to the next tab, the number in the tab title changes to
a check mark. If you make changes on a tab that significantly affect the settings set in a preceding tab,
the check mark in the tab title of the affected tab is replaced with the number again to indicate that you

should check the settings on that tab.

See also
B About Panels
m_Select Device Parameters

B Select a Test

B_Select Acquisitions
B_Configure Tests

B Select Test Notification Preferences

DUT tab, QSFP+ Tx compliance view

DUTID DUTON

= Acguire live wavefarms

vew [Compience | v
Acquisitions
" Results ) (3] e Standard |QSFP+Tx | ¥ |

" cratue ) a Test Selection

n Preferences Device Profile

+ Host tdodule

10G5FP+Cu Direct Attach Cable

Mumber of Lanes to Test
tLane ||
Selected Test Lanes @

Lanen

Status Ready |

_ TekExpress SFP+ QSFF v |

Use pre-recorded waveform files

version |SFF-8635 Revision 0.4 | v |
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Setup panel

DUT tab, QSFP+ Tx advanced view

DUTID DUTOD

@ Acguire live waveforms O Use pre-recorded waveform files

viw  [povanced | v

Standard

Device Profile

() Host ) Module

10G5FP+Cu Direct Attach Cable

Mumber of Lanes to Test
Tiane v
Selected Test Lanes i

Lanen

Status Ready |
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DUT tab, SFP+ Tx compliance view

DUTID DUTOD! @

(o) Acguire live waveforms | Use pre-recarded waveform files

Wiew

Standard

Comptance |7

Yarsion |SFF—B431 Revision 4.1 | v |

Device Profile

(+) Host () Module

10GSFP+Cu Direct Attach Cable

Status Ready |
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Setup panel

E

Test Selection tab, QSFP+ Tx host profile tests

QEFP+ Tx: Host : SFF-8635 Revision 0.4

Single Ended Output Voltage Range
Output AC Common Mode voltage (RMS)

E—Il--IE SFF-8431 Table 12 Jitter and Eye Mask Specifications at B
D Crosstalk Source Rise/Fall Time (20%-80%)

D Crosstalk Source Amplitude (p-p Differential)

Signal Rise/Fall Time (20%-80%)

-[w] Total Jitter

D Total Jitter @ J2 (Informative)

D Total Jitter @ J9 (Informative)

[~ Data Dependent Jitter
-{] Data Dependent Pulse Width Shrinkage
-[] Uncorrelated Jitter
Transmitter Qsq
[ Eye Mask Hit Ratio

S o] orr 494 Takla 9% Cudeod Cannsifinod

Test Description

Please select a test name to view its Description  »
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Acquisitions tab, QSFP+ Tx host profile

QSFP+ Tx: Host: SFF-8635 Revision 0.4

Lane0+ CH1 Lane1+ CH2
Laned-  CH3 Lane1- CH4

Test e Acqui

» Data Dependent Jitter Lane0 : Data Dependent Jitter Acquisi
Data Dependent Pulse Width Shrinkage Lane0 : Data Dependent Pulse Width
Eye Mask Hit Ratio Lane0 : Eye Mask Hit Ratio Acquisitio
Qutput AC Commeon Mode voltage (RME Lane0 : Qutput AC Common Mode vol
Output AC Common Mode voltage (RMS Lane0 : Output AC Common Mode voll
Single Ended Output Voltage Range  Lane0 : Single Ended Output Voltage

Signal Rise/Fall Time (20%-80%) Lane0 : Signal Rise/Fall Time (20%-8
Total Jitter Lane0 : Total Jitter Acquisition

Transmitter Qsq (for Cu) Lane0 : Transmitter Qsq (for Cu) AcqL
Transmitter Qsq Lane0 : Transmitter Qsq Acquisition
Host Output TWDPc Lane0 : Host Qutput TWDPc Acquisitic

a iiiiiiiiiii iiii i iiii - I Iillllllii'l "i'l Ammiiimiti,

Acquisition and Save Options r Show Acquire Parameters
All waveforms are saved before analysis

Signal Validation
IPrompt me if signal f... m
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Configuration tab, measurements (advanced view)

(+) Compliance Mode | User Defined Mode

Glohal Settings | Measurements

(=~ SFF-2431 Table 11 Output Electical Specifications at B

: Single Ended Output Yoltage Range

Output AC Commaon Mode voltage [RMS)

[=l- SFF-8431 Table 12 Jitter and Eve Mask Specifications at B
Configuration i- Signal Rise/Fal Time (20%-80%]

[rata Dependent Jitter

Data Dependent Pulse YWidth Shrinkage

Uncaorelated Jiter

Tranzmitter g

Fur b Ask Hit B Atin

Signal Type
AC Coupled PRBS31 |V |

Status Ready |
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Preferences tab

Analysis Options
[ On TestFailure, stop and notify me of the failure

~ Email >
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Status panel

Use the Status panel to track test measurement progress. The Status panel has two tabs: the Test Status tab
displays the acquire status and the analysis status of the tests as they are being executed; the Log View
tab (shown below) displays a view of the test log.

For more information on using the Status panel, see View the Progress of Analysis.

Test Status

Initializing run time environment, Thiz might take gome time,

05/21A13 01:40:57 : epec :5FF-8635 Revizsion 0.4

05/21/13 01:40:57 : Date/TIme :2013-05-21 01:40:57. 756000

05/21/13 01:40:57 : OSFPConstants. PRE_RECORDED_MODE : False

05/21/13 01:40:57 : MSO72004C [ GFIBE:1:IMSTR )

05/21/13 01:40:57 : Scope Addresz : GPIBE:1:IMSTR

05/21/13 01:40:57 : Scope Model : MS072004C

05/21/13 01:40:57 : fwher :6.7.4 Build 3

05/21/13 01:40:57 : DPQet Wersion :"6.0.1 Build 8"

05/21/13 01:40:57 : Scope Serial Mumber :C230691

05/21413 01:40:57 : Calibration Status |PASS

05/2113 01:40:57 : GetSelectedT ests: :['Sinale Endad Output Valtage Ranage’, 'Dutput AC Comman Mode valtages [RS))
05/2113 01:40:57 : Selected Tests : [Single Ended Output Vaoltage Range’, 'Dutput AC Common Mode voltage [RMS), 'S
05/21/13 01:40:57 : DF_SOURLCE : CH1

05/21/13 01:40:58 : DM_SOURCE CH3

05/21/13 01:40:68 : SIGMAL_VALIDATION_VALUE : Prompt me if signal fails

05/21/413 01:40:58 : Lane selected : Lanel

05/21/13 01:40:58 : tests : ['Single Ended Output Voltage Range', "Dutput AC Common Mode voltage [RMS]', 'Signal Rize/
05/21,/13 01:40:58 : Signal Type Lizt['AC Coupled PRES31', 'PRES 31", '8150°", PRESS]

05/21/13 01:40:58 : Total Signal Types:4

05/21/13 01:40:58 : For Lane0

05/21/13 01:40:58 : Acquiring waveforms for Single Ended Dutput Voltage Range Acquizition far signal AC Coupled PRES:

Status Completed. |

See also

B About Panels
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Test Status view

| Test Name

Output AC Common Mode voltage (RMS)

Signal RisedFall Time (20%6-30%)

Data Dependent Jiter
Data Dependent Pulze Width Shrinkage

Uncorrelated Jiter

Tranzmitter Q=g

Evye Mask Hit Ratio

Yolttage Modulstion Amplitude (p-p)

Tranzmitter Q=g (for Cu)
Output AC Common Mode voltage (RME) (far

cul
Hiost Output TWDPS

Output 28 Common Mode voltage
(RMS) Acguisition

Slgna.l I_?!SeJFaII Time [20%:-50%.) To be started
Acouisition

Data Dependent Jtter Acquisition To ke stared

Data Dependent Pulze Width
Shrinkage Acouistion

Uncorrelsted Jitter Acquisition Ta be started

To be started

To he started

Tranzmitter Qag Scouisition To be started
Eve Mask Hit Ratio Acquistion To be started

Woltage Mc-_dg!atmn Amplituce To be started
(p-p) Acouisition

Tranzmitter Q=g (for Cu)
Acquisition

Output AC Common Mode voltage
(RMS) (for Cu) Acouisition

Host Output TWOPS Scouisition  To be stared

To he started

To be started

Tao be started

To be started

Ta be started

To be started

To be started

To be started
Ta be started
Tao be started

Tao be started

To be started

Tao be started

To be started

Statuz Ready |
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Results panel

Results panel

When a test completes, the application switches to the Results panel to display a summary of test results.

NOTE. Results of Crosstalk measurements, Total Jitter @ J2, and Total Jitter @ J9 are not included in the

overall test results because these measurements are informative only.

Set viewing preferences for this panel from the Preferences menu in the upper right corner. Viewing
preferences include showing whether a test passed or failed, summary results or detailed results, and
enabling wordwrap. For information on using this panel, see View Test Results.

_V?gTekExpress SFP [ v |

Overall Test Result

Description

Signal Rise/Fall
B Time (20%-80%)

High Limit

Low Limit

RiseTime

PassFail Yalue

52,9379 18.9379
Pass

MN.A
34.0

Margin

Signal Rise/Fall
(=) Tirme (20%-80%)

High Limit
Low Limit

Data Dependent
(=) Pulse Width
Shrinkage

High Limit
Low Limit
(=) Uncorrelated Jitter
High Limit
Low Limit
(+) Transmitter Qsq

— \foltage

* Modulation

& Transmitter Qsi
{for Cu)

@ Host Output
TWDPC

Signal Rise/Fall
Time {20%-80%)
FallTime

Data Dependent
Pulse Witth
Shrinkage

Uncorrelated

Transmitter Qsqg

Voltage
Modulation

Transmitter Qsi
({for Cuj

Host Qutput

46.9951

M.A
0.0041
0.023
MN.A

142.8168
497.4027

142.8168

10,3854

12,9951

92.8168
197.4027

79.7168

0.3146

B R

See also

B About Panels
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Reports panel
Use the Reports panel to browse for reports, name and save reports, select report content to include, and
select report viewing options.

For information on setting up reports, see Select Report Options. For information on viewing reports,
see View the Report.

port name  [X:\SFP+ QSFP+ Tx\Reports\DUT001.1
ype | Web Archive (*.mht;* mhtml) | ¥ |

See also

= About Panels
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About test setups

TekExpress SFP+ QSFP+ Tx opens with the default setup selected for the default standard (QSFP+). Run
a test before or after saving a setup. When you save a setup, the test information, such as the selected
oscilloscope, general parameters, acquisition parameters, measurement limits, waveforms (if applicable),
and other configuration settings are all saved under the setup name. Use test setups to:

B Run a saved test in prerecorded mode.

B View all the information associated with a saved test, including the log file, the history of the test status
as it executed, and the results summary. For details, see Recall a Saved Test Setup.

B Create a new test setup based on an existing one.

See also

B About Setting Up Tests
BH_Save a Test Setup
m_Recall a Saved Test Setup
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Save a test setup

Save a test setup before or after running a test using the parameters you want saved. Create a new test

setup from any open setup or from the default setup. When you select the default test setup, all parameters

are returned to their defaults.

The following instructions start from the default test setup:
1. From the Options menu, select Default Test Setup.

2. Select the desired options in the Setup panel.

3. Select the desired report options.
4

If desired, run the test to be sure that it captures the desired information. If it does not, edit the
parameters.

5. From the Options menu, select Save Test Setup.

See also

B_ About Setting Up Tests

B Test Setup Overview

B View Test-Related Files
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Recall a saved test setup

These instructions are for recalling saved test setups.
1. From the Options menu, select Open Test Setup.

2. In the File Open dialog box, select the desired setup from the list and then click Open.

See also

B__About Test Setups
m_Create a New Test Setup Based on an Existing One
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Create a new test setup based on an existing
one

Use this method to create a variation on a test setup without having to create the setup from the beginning.

1. From the Options menu, select Open Test Setup.
In the File Open dialog box, select the desired setup from the list and then click Open.
Modify the parameters as desired.

From the Options menu, select Save Test Setup As.

LA

In the File Save As dialog box, enter a test setup name and then click Save.

See also

B__About Test Setups

B Select Device Parameters

®_ Configure Tests
m_Select Acquisitions
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Create a new test setup based on an existing one
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Setting up and configuring tests Create a new test setup based on an existing one
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About setting up tests

Set up tests using the tabs in the Setup panel. Settings in the DUT tab use a top-down, left-to-right logic
flow, so that any parameter that affects or acts as a filter for other parameters appears either above or
to the left of the affected parameters.

Test options: standards, views, and modes

Test options include two standards, QSFP+ Tx and SFP+ Tx (selected in the DUT tab of the Setup panel),
two views, Compliance and Advanced (selected in the DUT tab of the Setup panel), and two modes,
Compliance and User Defined (selected in the configuration settings of the Setup panel).

The selected standard determines which measurement standard will be used. The selected view determines
where the test configuration settings are displayed. The selected mode determines whether you can change
test configuration settings to include those that are noncompliant.

B Compliance View selected with Compliance Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically with
little or no user intervention. You will not be able to change test parameters to anything that deviates from
the compliance standards. The only test configuration parameters that you can change in this mode

are the Global Settings.

®  Compliance View selected with User-Defined Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically but
you will be able to change the parameters before starting the tests.

B Advanced View selected with Compliance Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically with
little or no user intervention. You will not be able to change test parameters to anything that deviates from
the compliance standards. The only configuration parameters that you can change in this mode are the
Global Settings.

B Advanced View selected with User-Defined Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically but
you will be able to change test parameters before starting the tests.

Supported tests

The application supports the following tests, grouped by profile.
Host Profile Tests

®  SFF-8431 Table 11 Output Electrical Specifications at B:

= Single Ended Output Voltage Range

= Output AC Common Mode voltage (RMS)
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m  SFF-8431 Table 12 Jitter and Eye Mask Specifications at B:
= Crosstalk Source Rise/Fall Time (20%—80%)

= Crosstalk Source Amplitude (p-p Differential)

- Signal Rise/Fall Time (20%—80%)

= Total Jitter

= Data Dependent Jitter

- Data Dependent Pulse Width Shrinkage

= Uncorrelated Jitter

= Transmitter Qsq

= Eye Mask Hit Ratio

®  SFF-8431 Table 33 Output Specifications at B for Cu:

NOTE. The group SFF-8431 Table 33 Output Specifications at B for Cu is associated with the 10GSFP+
Cu Direct Attach Cable device profile (the check box for this profile is located on the DUT tab of the Setup
panel). This group of tests is available only when this check box is selected.

= Voltage Modulation Amplitude (p-p)

= Transmitter Qsq (for Cu)

= QOutput AC Common Mode voltage (RMS) (for Cu)

= Host Output TWDPc¢

NOTE. An evaluation version of the Host Output TWDPc test is included in the SFP+ QSFP+ Tx
installation. You are allowed 10 free trials of this test. Each time you run the test, regardless of how
often you open the application, one of the free trials is used. To use this test after the evaluation
period, purchase the SFP-WDP option license key.

Module Profile Tests
m  SFF-8431 Table 16 Transmitter Input Electrical Specifications at B:

= AC Common-Mode Voltage Tolerance

= Single-Ended Input Voltage Tolerance
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m  SFF-8431 Table 17 Transmitter Input Tolerance Signal Calibrated at B:
= Crosstalk Source Rise/Fall Time (20%-80%)

= Crosstalk Source Amplitude (p-p Differential)

= Output AC Common-Mode Voltage (RMS)

= Total Jitter

= Data Dependent Jitter

- Data Dependent Pulse Width Shrinkage

= Uncorrelated Jitter

- Eye Mask Hit Ratio

m  Additional Supported Measurements for QSFP+ only
= Total Jitter @ J2
= Total Jitter @ J9

See also

B Test Setup Overview

B Before You Click Start

m__About Test Setups
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Equipment connection setup

To run tests, you need the following equipment (for details, see Minimum System Requirements):

® A supported Tektronix oscilloscope

®  The device under test

®  SFP+ or QSFP+ fixtures

Table 6: SFP+ and QSFP+ fixtures

Tektronix

nomenclature Description

TF-SFP-TPA-HCB-P SFP+ Host Compliance Board Plug
TF-SFP-TPA-MCB-R SFP+ Module Compliance Board Receptacle

TF-SF-TPA-PR SFP+ Host Compliance Board Plug and Module Compliance Board Receptacle

TF-SFP-TPA- SFP+ Host Compliance Board Plug Kit with DC Blocks and Termination

HCB-PK

TF-SFP-TPA- SFP+ Module Compliance Board Receptacle Kit with DC Block and Termination

MCB-RK

TF-SFP-TPA-PRK SFP+ Host Module Compliance Board and Module Compliance Board with DC Blocks and
Termination

TF-QSFP-TPA- QSFP+ Host Compliance Plug

HCB-P

TF-QSFP-TPA- QSFP+ Module Compliance Board Receptacle

MCB-R

TF-QSFP-TPA-PR QSFP+ Host Compliance Board Plug and Module Compliance Board Receptacle
TF-DC-BLOCK-KIT DC Block Kit

Equipment connections can vary by Device Profile (Host and Module) and by individual test. Refer to the
following connection diagrams when setting up equipment for testing.
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Connection setup for Host tests

B Table 12 Crosstalk Source tests

Digital Oscilloscope

il

0
0
0
0
o

Crosstalk Source

Oz
Y80ls8
s 5 o o Q
bobb c
O
EEFEEEER
COEFTEERE
T T
Connector
Par RX- lii,iu 11
>E0E) — i
Rx+ | .
‘ Host Compliance Board y t
Stressed Tx+ o easuremen
Signal i: :; o :F Instrumentation
Generator Tx- ] or 2x50
Module Compliance Board o
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m  All other Host tests

Digital Oscilloscope

Q&0lss
6500
Crosstalk Source [ B & & 35]
. += =+
8 Crosstalk —»
G
[~ ]C+ve
8 C-ve
SFP+/QSFP+| HCB . B+ve
I B-ve
DUT
= DC Blocks

0590-009

Test setup for all measurements other than single-ended output voltage range

Digital Oscilloscope

O88ls2
56005
Crosstalk Source 'E]
o ]
8 Crosstalk —» \
G
12 db
Attenuators
[~ ] C+ve
8 C-ve
SFP+/QSFP+| HCB LBt
IS B-ve
DUT
0590-008

Test setup for single ended output voltage range measurement on DPO/DSA70000D series oscilloscopes
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Digital Oscilloscope

== ]

Soommoo

O 2lezg

084|53

c 000

bbb

i q

Crosstalk Source [‘] i m]

Crosstalk ——»

PPOoOO

[~ ] C+ve

8 C-ve
SFP+/QSFP+| HCB LBt

iB-ve
DUT

0590-007

Test setup for single ended output voltage range measurement on all oscilloscopes other than DPO/DSA70000D
series oscilloscopes

Connection setup for module tests

= Single-Ended Input Voltage Tolerance Test

o Connec’;on
> /N % Bl >
Measurement | /7 o length | | 1 Module Under test | | Input/Output
Instrumentation H‘_ \ line
=T
% ol TN

Module Compliance Board

0280004

®  All other Module tests
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Equipment connection setup

. Connector
2x00 Q or 40 gl Crosstalk
Scope = | rosstalk source
| o
Trace length | Host Compliance Board | p»
Stressed 9 - B Measurement
signal » Instrumentation
genertor L— =
Maodule Compliance Board
0590-003
See also

®_View Connected Instruments

B__About Setting Up Tests

®_ Oscilloscope Setup
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View connected instruments

52

Use the Instrument Control Settings dialog box to view or search for connected instruments required for
the tests. The application uses TekVISA to discover the connected instruments.

To refresh the list of connected instruments:

1.
2.

From the Options menu, select Instrument Control Settings.

In the Search Criteria section of the Instrument Control Settings dialog box, select the connection
types of the instruments to search for. By default, only the GPIB resource type is selected but you can
select as many types as your system and setup use.

Instrument search is based on the VISA layer but different connected cables determine the resource
type, such as LAN, GPIB, USB. For example, if you choose LAN, the search will include all the
instruments supported by TekExpress that are communicating over the LAN. If the search does not
find any instruments that match a selected resource type, a message appears telling you that no such
instruments were found. If you selected more than one resource type for the search, after you close the
message window, the application will continue searching for the other selected types.

Click Refresh. TekExpress searches for connected instruments.

After discovery, the dialog box lists the instrument-related details based on the selected search criteria.
For example, if you selected LAN and GPIB as the search criteria, the application checks for the
availability of instruments over LAN, then GPIB.

TekExpress Instrument Contrel Settings

 Conmection
¥ VISA-GPIB
 MISALAN DPO5204 PRO00008
 MISALAN DPO73304C CHARDS
 MISALAN 400024100 @300002
 MISALAN DPO70804 204

May 16, 2001 17:43:47 L h

The Retrieved Instruments table displays details about the instruments. The time and date of instrument
refresh is displayed in the Last Updated field.
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See also

B_ Configure Tests
®__Equipment Connection Setup
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Test setup overview

Test setup includes acquisition and configuration parameters, but you can also select report options when
setting up tests. Use the options in the Setup panel and Reports panel to select and configure tests.

Select device parameters.

Select one or more tests.

Select acquisitions.

Configure tests.

Set test measurement notification options.

CANE L S

Select report options.

See also
B Before You Click Start

®_ Pre-Run Checklist

B About Running Tests

54 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Setting up and configuring tests Select device parameters

Select device parameters

Use the Setup panel DUT tab to select settings for the device under test. Options selected here affect
which tests are available in the Test Selection tab.

1. In the Setup panel, click the DUT tab.

2. Ifneeded, in the DUT ID field, enter the ID for the device. The default value is DUTO001. The name in
this field appears on reports.

3. (Optional) To add comments that will appear at the top of the test Report for the selected DUT, click

the note pad icon ( L) ) to the right of the DUT ID field and specify a comment up to 256 characters.
(To enable or disable comments appearing on the test report, see Select Report Options.)

4. Select whether to use a prerecorded waveform file or a live waveform for testing.

If you are rerunning a saved test and select to use a prerecorded waveform file, select the desired run
session. For more information, see Run a Saved Test in Prerecorded Mode.

5. For View, select Compliance or Advanced.

NOTE. [fyou select Advanced View, the configuration settings are included in the Setup steps as step 4. [
Y g g p step P

you select Compliance View, the configuration step is not included as a separate step. Access configuration

parameters for selected tests from the Configure button in the Test Selection tab.

6. For Standard, select QSFP+ Tx or SFP+ Tx. If you select the QSFP+ Tx standard, you can configure
which lanes to test as described in step 8.

7. For Device Profile, select one:

= Host (default). Select this option to enable selecting Host tests listed in the Test Selection tab.
To include measurements related to an attached copper cable, select the 10GSFP+Cu Direct
Attach Cable check box.

= Module. Select this option to enable selecting Module tests listed in the Test Selection tab.
8. To configure the lane selection:
= Use the Number of Lanes to Test drop-down box to select 1 Lane, 2 Lanes, or 4 Lanes.

= Click the Selected Test Lanes Setup button to open the Test Lane Setup dialog. Use the dialog to
configure which lanes to test.

See also

u__About Setting Up Tests

B Select a Test

B_ Use Prerecorded Waveforms for Analysis
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B_Acquire Live Waveforms for Analysis

Test Lane Setup dialog

X
—Test Lane Setup
lane v
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Select a test

Tests listed in the Test Selection tab depend on whether you selected Host or Module in the DUT tab. The
available tests are the same for both standards (QSFP+ Tx and SFP+ Tx). Use these instructions to select
the tests to run on the connected DUT. Select tests individually or by group. To see a short description of a
test, select the test in the list.

[y
.

In the Setup panel, click the Test Selection tab.

g

All required tests are selected by default. Click Deselect All if you do not want to run all required tests.

w

Select the desired test(s):
= To select all required tests, click the Select Required button.
= To select all tests in the list, click the Select All button.

= To select an entire test group, select the check box for the test group; tests listed under the group
are automatically selected.

= To select one or more, but not all, tests in a test group, select only the check boxes for the desired
tests.

Test Selection Controls

Table 7: Setup panel test controls

Button Description
g ' When the View type selected in the DUT tab is Compliance,
e this button opens the configuration section for the selected
test. If the View type is Advanced, this button is not displayed.
: Displays the schematic document for the selected test. Use to
- verify the test setup before running the test
Deselect Deselects all tests in the table
SebiC Selects tests required for compliance and deselects all other
tests currently selected
@ Selects all tests in the table
See also

B_ Select Acquisitions
B__About Setting Up Tests
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About acquisitions
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Use the Acquisitions tab in the Setup panel to view and set acquisition and save options for the selected
tests.

The information on the Acquisitions tab is specific to a test suite and gets updated when you change the
selected test suite. This tab shows the acquisition details for the tests in the currently selected suite. Other
options available depend on whether you selected the QSFP+ Tx or the SFP+ Tx standard, selected to
acquire live waveforms, or selected to use prerecorded waveform files.

For example, the top part of the Acquisitions tab is the data source selection area. The information that
appears here depends on the selected standard, the number of lanes to be tested (QSFP+ Tx only), whether
you are using prerecorded waveforms or live waveforms, and whether you selected Host profile or Module
profile in the DUT tab.

Below the data source selection area is the test acquisition and mapping table. The Acquisitions table
shows the test name, acquisition, and signal type used for each test, and the waveform files used for
tests run in prerecorded mode.

Table 8: Acquisitions table

Column Name Function

Test Name Displays the name of the selected test to which the
acquisitions apply. One or more tests can perform the
same acquisitions.

Acquisition The acquisition of the waveform for the corresponding test

Signal Type Shows the acquisition parameters of the signal. This
column is displayed only if the Show Acquire Parameters
check box is selected in the Acquisition and Save Options
section.

Waveform File Lists the name of the waveform files used for the test.
Select waveform files by clicking the button in the row
and selecting any waveform file using the standard File
Open window. This option is available only when Use
pre-recorded waveform files is selected in the Setup
panel DUT tab.

See also

m_Select Acquisitions
B__About Setting Up Tests
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Select acquisitions

Use the Acquisitions tab in the Setup panel to view and set acquisition parameters for selected tests.
Options available depend on whether you are testing using live waveforms or prerecorded waveform files.

1. In the Setup panel, click the Acquisitions tab.
2. Do one of the following:

= For prerecorded waveform files: in the Acquisitions table, locate the row for the desired test and

then click the ellipsis button (&) in the Waveform FileName column. Select Data Positive (DP)
and Data Negative (DN) waveforms for each test.

= For capturing live waveforms, select the Data Source channels for positive and negative signals
if needed.

3. Deskew channels.

4. Select the acquisition and save options.

See also

B_ Configure Tests
u__About Setting Up Tests
B Test Setup Overview
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Acquisition parameters

Available acquisition options depend on the selected mode (Compliance or User Defined) and the type of
waveform being used, live or prerecorded.

Table 9: Acquisition and save options

Option Description

Show Acquire Parameters When selected, the signal acquisition parameter for each test displays in the Signal
Type column.

NOTE. The rest of the options in this table are available for live waveform acquisitions only.

Data Source (+) Sets the channels used for positive and negative data sources. When QSFP+ Tx is

Data Source (-) the selected standard, data sources for each lane to be tested can be configured.

Signal Validation: Determines how the application responds to the source signal

= Prompt me if signal fails If the signal fails, pauses the measurement operation and displays a dialog box

with the following options:

Signal ¥ahdation Failed

@ Imvalid Signal, what do :h bo do?

Continue Skip Test ReAcquire

®  Reacquire: Try acquiring the signal again.
= Use Anyway: Use the signal even if it cannot be validated.

B Skip Test: Abort the test if the signal cannot be validated.
= Use signal as is—Don't Check Skips the signal validation process. Does not test the signal for its characteristics

B Skip test if signal fails Moves to the next test (if applicable) if the signal fails
NOTE. The following Save options affect the order in which waveforms are acquired and analyzed.
Save All Waveforms Before Waveforms will be saved before being analyzed.

Analysis

See also

B__About Acquisitions
m_ Select Acquisitions
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Use prerecorded waveforms for analysis

Use prerecorded waveform files to run saved tests or to run a new test using a saved waveform from
another test.

Run a saved test in prerecorded mode.

Run a new test using a prerecorded waveform file.

1.

U S

Create a new test.

In the DUT tab of the Setup panel, select Use pre-recorded waveform files.

Change any other DUT parameters as desired.

In the Test Selection tab, select the desired test(s).

In the Acquisitions tab, locate the Waveform FileName column in the Acquisitions table. Click the

ellipsis button (&) for each test and select Data Positive (DP) and Data Negative (DN) waveforms for
each test.

Change or select other parameters as needed and then click Start to run the test.

See also

m_ Test Setup Overview

B__About Acquisitions

B_ Configure Tests
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Acquire live waveforms for analysis

Use these instructions to set up acquisition for a live waveform.

1. Open a saved test setup or create a new one.

2. In the Setup panel DUT tab, enter the desired DUT in the corresponding field if needed and then
select Acquire live waveforms.

Select other DUT parameters as desired.

In the Test Selection tab, select the desired test(s).

In the Acquisitions tab, select the channels for the positive and negative data sources if needed.

Deskew channels if needed.

Select other desired acquisition and save options.

ol A A ol o

Configure the tests if needed and then click Start to run the test.

See also

B__About Acquisitions
B_ Select Acquisitions
m_Use Prerecorded Waveforms for Analysis
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About configuring tests

Use configuration settings to view and edit the analysis parameters for selected tests.
The Configuration tab shows Global Settings parameters and Measurement parameters.

Global Settings parameters are common for all tests and are applied to all tests in the session until you
change the settings or select a different test setup.

_V'gTekExpress SFP+ QSi v | o

« Compliance Maode User Defined Mode @ é
Global Settings

Instruments Detected

Acquisitions Real Time Scope MSOF2004C { GPIES::1:INSTR. )

Preferences

Record Length Data Rate(Ghps)
5M v | [103125

Use Filter File for De-embedding (4l Test except TWDPC)
Select Filter File

UUse Filter File for De-embedding for TWOPC

Select Filter File

Status Completed. |

NOTE. The Use Filter File for De-embedding (only for TWDPC) check box is available only if the test
Host Output TWDPC is selected in the Test Selection tab.

Measurement parameters are specific to the test selected in the tree view section of the configuration
settings. Test-specific parameters can include acquisition, analysis, and limit parameters, and certain
oscilloscope settings.

Whether you can configure settings depends on which mode you selected, Compliance or User Defined.
For more information, see About Setting Up Tests.
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Glohal Settings | Measurements

Single Ended Output Yoltage Range
Output AC Common Mode woltage [Fik5)
= SFF-8431 Table 12 Jitter and Eye Maszk Specifications at B
: Signal Rize/Fall Time [205-80%)
[rata Dependent Jitter
Data Dependent Pulse Width Shrinkage
Uncorelated Jitter
- Tranzmitter Qg
- Eye Mask Hit Ratio
=l SFF-A431 Tahle 33 Mottt Snecifications at B far D

(=) Compliance Mode | User Defined Mode i

Signal Type
AC Coupled PRBS31 | ¥ |

Status Completed. |

NOTE. Ifyou selected Compliance View in the DUT tab, you will access test configuration settings using
the Configure button in the Test Selection tab. If you selected Advanced View, access test configuration
settings from the Configuration tab in the Setup panel.

See also

B_Configure Tests
B__About Running Tests

64 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Setting up and configuring tests Configure tests

Configure tests

Use these instructions for configuring tests.

1. Do one of the following:
- If you selected Compliance View in the DUT tab, then in the Test Selection tab, select the desired
test in the list and click Configure.
NOTE. To return to test selection from the Configuration section, click the Test Selection button.
= Ifyou selected Advanced View, click the Configuration tab in the Setup panel.
2. Select the desired mode:
= Compliance Mode: Select to use Compliance Mode values. You cannot change most test
parameters in Compliance mode but you can view the parameters.
- User Defined Mode: Select to run tests with custom parameters.
3. To select parameters that apply to all tests selected for the current session, click the Global Settings
tab and do any of the following:
= To change the oscilloscope used for testing, in the Instruments Detected section, click in the
shaded area opposite Real Time Scope and select the desired instrument from the drop-down list.
If the oscilloscope you want is not listed, refresh the list.
= To select a filter file for de-embedding the signal, select the Use Filter File for De-embedding
check box. Click the Browse button that appears and select a filter file to use.
= To select a filter file for de-embedding the signal for Host Output TWDPc tests, select the Use
Filter File for De-embedding (only for TWDPC) check box. (Available only if the Host Output
TWDPc test is selected in the Test Selection tab.) Click Browse and select a filter file to use.
4. To change the signal for a specific test (in User Defined Mode), click the Measurements tab, select the
test in the tree view section and then select the signal type in the Acquire section.
5. To view test limits (in Compliance Mode) or change test limits (in User Defined Mode), click the
Limits Editor button to access the Limits Editor window.
See also

B Common Test Parameters and Values

m_De-embed Using Filter Files
B_ Select Report Options
B__About Setting Up Tests
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Common test parameters and values

66

The following table lists the measurement parameters common to most tests.

NOTE. Ifyou change the channel selection for Data+ (DP) and Data— (DN) signals, make sure that you
change the corresponding trigger source in the Analyze tab for each of the measurements. If you do not do
this, the waveform might not trigger and the measurements might not be completed.

Table 10: Common parameters and values

Parameter Type Parameter and Default Value

Mode Determines whether test parameters are in compliance or can be edited
B Compliance: Most test parameter values cannot be changed.

m  User Defined: Most test parameter values can be changed.

Global Settings These settings apply to all tests selected for the current session. You can
change only some of these settings.

® Real Time Scope: Specifies the oscilloscope used for tests
®m Record Length: Specifies the length of the record (5M is the default)

B Use Filter File for De-embedding: When selected, provides a browse
button and field for selecting a filter to use to compensate for cable lengths.

®m  Use Filter File for De-embedding (only for TWDPC): When selected,
provides a browse button and field for selecting a filter to use to
compensate for cable lengths.

= Data Rate: Select the signal data rate as one of 9.95328 Gbps,
10.3125 Gbps (default), 10.51875 Gbps, or 11.10 Gbps.
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Table 10: Common parameters and values (cont.)

Parameter Type Parameter and Default Value
Measurements Acquire:

®  Signal Type: Specifies the signal type of the acquisition for the test
selected in the tree view of the Measurements tab. Running tests in User
Defined Mode allows you to perform the tests on different types of signal.
The default signal type varies by test. Not all tests support all the signal
types. For each test, the application includes the signal type options that
are best suited to the measurements.

®  Window Size (%): Host test Transmitter Qsq only. Set at 10% for
Compliance Mode. In User Defined Mode, you can change this to 5%
or 20%.

Limits Shows the upper and lower limits for the applicable measurement using
different types of comparisons. In Compliance Mode, allows you to view the
measurement high and low limits used for the test selected in the tree view of
the Measurements tab. When running tests in User Defined Mode, you can
edit the limit settings in the Limits Editor.

Limits Editor
Yiew or Edit the val

A blank cell means no

Test Name Details Compare String Low Limit Compare String High Limit
Crosstalk Source ... Crosstalk Source A, == Equal To 1000

Crosstalk Source Ri... == Equal To Gt
Crosstalk Source ...
Crosstalk Source Fa... == Equal To 34

Data Dependent ... DataDependent Jit... < Less Than a1

Data Dependent ... DataDependent Pu... < Less Than
Eye Mask Hit Ratio Eye MaskHit Ratin < Less Than <Less Than
Signal Rise Time (pS) > Greater Than >= Greater Than Or Equal To
signal Rise/Fall T... <= Less Than Cr Equal To
Signal Fall Tme {pS) = Greater Than

Total Jitter Tokal Jitker (LI} < Less Than

When running tests in User Defined Mode, the cells in the Limits Editor
table are active for editing so you can change parameters.

See also

®_ Configure Tests
m_ Select Acquisitions
m_De-embed Using Filter Files
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Configure email notification

To be notified by email when a test completes, fails, or produces an error, configure the email settings.
1. From the Options menu, select Email Settings to open the Email Settings dialog box.

2. (Required) For Recipient email Address(es), enter your email address. To include multiple addresses,
separate the addresses with commas.

3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists
of the instrument name followed by an underscore followed by the instrument serial number, then the
@ symbol and the email server used. For example: DPO72004C B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server
configured at the client location, and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name
in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not be saved and email
notifications will not be sent.

5. In the Email Attachments section, select from the following options:
= Reports: Select to receive the test report with the notification email.

= Status Log: Select to receive the test status log with the notification email. If you select this
option, then also select whether you want to receive the full log or just the last 20 lines.

6. In the Email Configuration section, select as desired:
= Select the message file format to send: HTML (the default) or plain text.

= Enter a maximum file size for the email message. Messages with attachments larger than this
limit will not be sent. The default is 5 MB.

= To limit the number of attempts the system makes to send a notification, enter the number in the
Number of Attempts to Send field. The default is 1. You can also specify a timeout.

7. Select the Email Test Results When complete or on error check box. Use this check box to quickly
enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.
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Email settings
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Select test notification preferences

Select how you want to be notified by the system when a test measurement fails:
1. In the Setup panel, click the Preferences tab.
2. Select the following option:

= On Test Failure, stop and notify me of the failure: Select this option to have the test stop and
notify you by email if the test fails. If you select this option, select the Email Test Results when
complete or on error check box in the Email Settings dialog box. Click Email Settings and
configure the email settings if you have not already done so.

See also

B__About Setting Up Tests
B_Select Report Options
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Select report options

Use the Reports panel to select which test information to include in the report, and the naming conventions
to use for the report. For example, always give the report a unique name or select to have the same name
increment each time you run a particular test. Generally, you would select report options before running a
test or when creating and saving test setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:

Table 11: Report options

Setting

Description

Generate new report

Creates a new report.

Append with previous
run session

Appends the latest test results to the end of the current test results report.

Replace current test
values with the new
results

Replaces the previous test results with the latest test results. Newly added tests results are
appended to the end of the report.

Report name

Displays the name and location where the report will be saved when generated. This field is
blank by default. The report and related files are stored in the Untitled Session folder located at
\My TekExpress\SFP+ QSFP+ Tx\Untitled Session by default. The report file
in this folder gets overwritten each time you run a test, and gets deleted when you close the
application. To preserve your test results, specify a unique name or select to auto increment the
report name, then save the test before running another test or exiting the application.

Change the report name or location.
Do one of the following:
®  In the Report Name field, type over the current folder path and name.

B Double-click in the Report Name field and then make selections from the
popup keyboard and click the Enter button.

Be sure to include the entire folder path, the file name, and the file extension. For example:
C:\Documents and Settings\<your user name>\My Documents\My TekExpress\SFP+ QSFP+
Tx\DUTO001_group1.mht.

NOTE. You cannot set the file location using the Browse button.

Open an existing report.

Click Browse, select the report file and then click View at the bottom of the panel.

Save as type

Saves a report in a file type different from the default. Lists supported file types .mht and .pdf.

Auto increment
report name if
duplicate

If the application finds a report with the same name as the one being generated, the application
automatically increments the name of the report. For example: DUT001, DUT002, DUT003. This
option is enabled by default. This option is not available if Append Reports is selected.

Include pass/fail
results summary

The color block labeled Test Result indicating whether the test passed or failed will be included in
the report. For details, see Report Contents in View a Report.

Include detailed
results

The report will include parameters measured, such as Margin, Low Limit, High Limit, Compliance
Mode Yes/No, Execution Time, and test-specific Comments generated by the software.
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Table 11: Report options (cont.)

Setting

Description

Include plot images

Screen shots captured from the oscilloscope during test execution that show the waveform and
measurement data will be included.

Include setup

Information about hardware and software used in the test will be included in the summary box

configuration at the beginning of the report. Information includes: the oscilloscope model and serial number,
firmware version, SPC and factory calibration status, and software versions for applications used
in the measurements.

Include user Select to include any comments about the test that you or another user added in the DUT tab of

comments the Setup panel. Comments appear in the Comments section under the summary box at the
beginning of each report.

Group test The report can be grouped either by test name or by lane. This option is for QSFP+Tx standard

only.

Append reports

This option adds new report data to the end of an existing report of the same name. This option is
disabled by default. This option is not available if the Auto Increment Report Name if Duplicate
option is selected.

View report after
generating

Automatically opens the report in your Web browser when the test completes. This option is
selected by default.

See also

B View a Report

B__About Setting Up Tests
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About running tests

After selecting and configuring tests, review the pre-run checklist and then click Start to perform the tests.
The application acquires and analyzes the data, then displays a report when the tests are finished.

While the tests are running, other applications may display windows in the background. The TekScope
application takes precedence over other applications, but you can switch to other applications by using
the Alt+Tab key combination. To keep the TekExpress SFP+ QSFP+ Tx application on top, select Keep
On Top from the SFP+ QSFP+ Tx Options menu.

See also

m_Before You Click Start

BH__About Configuring Tests
B About Setting Up Tests
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Before you click start

Before you run tests for the first time, do the following:
1. Understand where your test files are stored on the instrument.

After you install and launch TekExpress SFP+ QSFP+ Tx, it creates the following folders on the
oscilloscope:

= \My Documents\My TekExpress\SFP+ QSFP+ TX
= \My Documents\My TekExpress\SFP+ QSFP+ Tx\Untitled Session

Every time you launch TekExpress SFP+ QSFP+ Tx, an Untitled Session folder is created in
the SFP-Tx folder. The Untitled Session folder is automatically deleted when you exit the
SFP+ QSFP+ Tx application. To preserve your test session files, save the test setup before exiting the
TekExpress application.

CAUTION. Do not modify any of the session files or folders because this may result in loss of data or
corrupted session files. Each session has multiple files associated with it. When you save a session, a . TekX
file, and a folder named for the session that contains associated files, is created on the oscilloscope X: drive.

2. Map the shared My TekExpress folder as X: (X drive) on the instruments used in test setups running
Microsoft Windows Operating System.

The My TekExpress folder has the share name format <domain><user ID>My TekExpress. Or, if
the instrument is not connected to a domain, the share name format is <instrument name><user
ID>My TekExpress. This shared folder is used to save the waveform files and is used during other
file transfer operations.

NOTE. If'the X: drive is mapped to any other shared folder, the application will display a warning message
asking you to disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access, and that the contents are not set
to be encrypted:

a. Right-click the folder and select Properties.
b. Select the General tab and then click Advanced.

c. Inthe Advanced Attributes dialog box, make sure that the option Encrypt contents to secure
data is NOT selected. Example.
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Lo My TekExpress Properties E3

General | Sharing I Secrity I Previous Versiots Eustomize|

Advanced Attributes 2

Choose the settings vou want For this Folder,

When ywau click OF or Apply on the Properties dialog, you will be
asked if you want the changes to affect all subfolders and files
as well,

Archive and Index attributes

[ Folder is ready For archiving

Allow files in this Folder ko have contents indexed in addition to File
properties

Compress or Encrypt attributes
Compress contents ko save disk space
crypt contents to secure data Details

[ oK ] [ Cancel

(1] 4 H Cancel ] Apply

4. See the pre-run checklist before you run a test.

See also

B_ Configure Tests
B_View Test-Related Files

B Application Directories and Usage

m_File Name Extensions
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Pre-Run checklist

Do the following before you click Start to run a test. If this is the first time you are running a test on a
setup, refer to the information in Before You Click Start.

1. Make sure that all the required instruments are properly warmed up (approximately 20 minutes).
2. Perform Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.

b. Select Instrument Calibration.

3. Deskew channels.

4. Verify that the application is able to find the DUT. If it cannot, perform a search for connected
instruments.

a. In SFP+ QSFP+ Tx, select the Setup panel and then click the Test Selection tab.
b. Select any test and then click Configure.
c. In the Configuration section, click Global Settings.

d. In the Instruments Detected section, click the drop-down arrow to the right of Real Time Scope
and make sure that the oscilloscope with the (GPIB8::1::INSTR) designation is in the list.

See also

B__Equipment Connection Setup
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Run a saved test in prerecorded mode
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Use this option to rerun a complete test using just the oscilloscope and the saved test setup files, provided
that you selected to save the captured waveforms when you originally ran the saved test.

NOTE. When you run a saved test in prerecorded mode and then save it under the same name, the test
results are saved in a new session folder named for the date and time of the session. Any test settings that
you changed for the session will be saved as a new test session file and be paired with a folder of the same
name. Example. When you open a test setup that has multiple sessions and you select a session from the
Run session list in the DUT tab, the settings associated with that test session are restored.

J 20111017 143500
J 20111017 143842
J 20111017 144545
J 20111017 144933
v 20111017 _143500
v 20111017 143842
vl 20111017 144645
v 20111017 144933

Each test session folder has a matching test session file that stores the individual test settings for that session.

1. Open a saved test setup.

2. In the Setup panel, select the DUT tab and then select Use pre-recorded waveform files.
A Run session drop-down list appears that displays the previous saved sessions for this test.

3. From the Run session list, select the session to run.

NOTE. Ifyou select a session for which no waveform files were saved, you will receive an error message.
Either select another test session or select waveform files to use. For details, see Step 2 of Select

Acquisitions.

4. Click Start.

5. To save the test results, session settings, and related files, save the test setup before selecting another
test setup or exiting TekExpress SFP+ QSFP+ Tx.

See also

B_Use Prerecorded Waveforms for Analysis
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View the progress of analysis

The Status panel displays a record of the test as it is executed. By default, the application switches to this
panel after you click the Start button to run a test. Choose from the following two views by selecting
the named tab, even while a test is in progress.

Test Status

The Test Status tab presents a collapsible table with information about each test as it is running. To
collapse and expand the table, click the expand (&d/id) collapse button.

Table 12: Status tab table

Column Description
Test Name Name of the test
Acquisition Describes the type of data being acquired

Acquire Status

Progress of the acquisition:
B To be started
= Completed Acquisition

®  Prerecorded waveform

Analysis Status

Progress state of the analysis:

To be started

B |n progress

Completed
E  Aborted

Log View

The Log View tab provides a list of actions that happen as the test executes. Use this tab to review or

troubleshoot tests.

Table 13: Log view options

Item

Description

Message History

This window timestamps and displays all run messages.

Show Detailed Log

Select this check box to record a detailed history of test execution.

Auto Scroll Select this check box to have the program automatically scroll down as information is added
to the log during the test.
Clear Log Click this button to clear all messages in the Message History window.
Save Use to save the log file as a text file for examination. Displays a standard Save File window and

saves the status messages in the file that you specify.
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See also

B View Test Results

80 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



Running tests and viewing results View test results

View test results

When a test completes running, the application switches to the Results panel, which shows a summary of
test results. The Overall Test Result is displayed at the top left of the Results table. If all of the tests for the
session pass, the overall test result will be Pass. If even one test out of multiple tests fails, the overall test
result will show Fail, even if all the other tests passed.

NOTE. Results of Crosstalk measurements, Total Jitter @ J2, and Total Jitter @ J9 are not included in the
Overall Test Results because these measurements are informative only. If any of the Crosstalk tests or
Total Jitter @ J2 and Total Jitter @ J9 fails, it will not cause the overall test results to fail.

Each test result occupies a row in the Results table. By default, results are displayed in summary format
with the measurement details collapsed and with the Pass/Fail column visible. Change the view in the
following ways:

B To expand all tests listed, select View Results Details from the Preferences menu in the upper right
corner.

m  To expand and collapse tests, click the plus and minus buttons.

B To collapse all expanded tests, select Preferences > View Results Summary.

B To hide or show the Pass/Fail column, select Preferences > Show Pass/Fail.

B To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.

B To expand the width of a column, place the cursor over the vertical line that separates the column
from the column to the right. When the cursor changes to a double-ended arrow, hold down the mouse
button and drag the column to the desired width.

B To sort the test information by column, click the column head. When sorted in ascending order, a
small up arrow is displayed. When sorted in descending order, a small down arrow is displayed.

B To clear all test results displayed, click Clear.

See also

®_View a Report

B_ View the Progress of Analysis
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View a report

After the analysis, a report is automatically generated. By default, the report is displayed in your Web
browser unless you cleared the View Report After Generating check box in the Reports panel before
running the test. If you cleared this check box, or to view a different test report, do the following:

1. In the Reports panel, click the Browse button and locate the desired report.

The path to the report displays in the Report Name field.

NOTE. If you did not save the test setup after running the report and you either closed the application or
you ran another report, the report file was not saved.

2. At the bottom of the Reports panel, click View.

For information on changing the file type, file name, and other report options, see Select Report Options.

Report contents

In the report, a table shows the test name, measurement details, test result (pass/fail), mode, and analysis
time.

Setup Configuration Information

Setup configuration information is listed in the summary box at the beginning of the report. This
information includes the oscilloscope model and serial number, and software versions. To exclude this
information from a report, clear the Include Setup Configuration check box in the Reports panel before
running the test.

Tektronix: TekExpress QSFP+
Host Test Report

Setup Inf
DUT ID DUTO001 TekExpress Version SFP+/QSFP+ 3.1.0.126
Spec Version SFF-8635 Revision 0.4 Scope Model DPO72004C
Date/Time 2013-10-16 05:30:53 FW Version 6.8.1 Build 3
Compliance Mode True DPOJet Version 6.1.0.509
Overall Execution Time 0:16:09 Scope Serial Number B130233
Overall Test Result Pass Calibration Status PASS

DUT COMMENT: General Comment - QSFP + Transmitter Host DUT
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User Comments

These appear in the Comments section directly below the summary box at the beginning of the test
report. To exclude these comments from a report, clear the Include User Comments check box in the
Reports panel before running the test.

Pass/Fail Summary

The Pass/Fail Summary column indicates whether a test passed or failed. If the test passed, the column cell
is green. If the test failed, it is red. To exclude this information from a report, clear the Include Pass/Fail
Results Summary check box in the Reports panel before running the test.

Measurement
Details
Single Ended
Output Voltage Lane0 -0.1818 v Pass 0.1182 N.A -0.3
Range Min(V)
Single Ended
Output Voltage Lane0 0.162 v Pass 3.838 4.0 N.A
Range Max(V)
Single Ended
Output Voltage Lanel -0.1776 A Pass 0.1224 N.A -0.3
Range Min(V)
Single Ended
Output Voltage Lanel 0.1584 A Pass 3.8416 4.0 N.A
Range Max(V)

COMMENTS Signal Type :AC Coupled PRBS31.

Lane Measured Value | Units Test Result Margin High Limit Low Limit

Back to Summary Table

Detailed Results

Includes detailed measurement information, as shown outlined in red in the following example. The
Comments column is for test-specific information that isn’t covered elsewhere. To exclude this information
from a report, clear the Include Detailed Results check box in the Reports panel before running the test.

Single Ended Qutput Voltage Range Pass
Output AC Common Mode voltage (RMS) Pass
Transmitter Qsq Pass
Eye Mask Hit Ratio Pass
Voltage Modulation Amplitude (p-p) Pass
Transmitter Qsq (for Cu Pass

Qutput AC Common Mode voltage (RMS) (for Cu) Pass
Host Output TWDPc Pass

Measurement Details| Measured Value Units Test Result Margin High Limit Low Limit

Single Ended Qutput
Voltage Range Min -0.1776 v Pass 0.1224 N.A -0.3

Single Ended Qutput
Voltage Range Max 0.16 v Pass 3.84 4.0 N.A

COMMENTS | Signal Type :AC Coupled PRBS31.

Back to Summary Table

Details d Value Units Test Result Margin High Limit Low Limit
Qutput AC Common
Mode voltage (RMS) 8.1908 mv Pass 6.8092 15.0 N.A
COMMENTS [ signal Type :PRES31

Back to Summary Table
. /
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Plot Images

Plot images are screen shots captured from the oscilloscope during test execution. They show waveform
and measurement data. To exclude these from a report, clear the Include Plot Images check box in the
Reports panel before running the test.

\cq | Trig | Display | Cursors | Measure | Mask | Math | MyS yze | Utilities

|
‘ |
) |

T 72.2mV 2.0us | S, 100GS/s 10.0ps/pt

FITTh 72.2mV 1000ps -6.01us -6.0us ) Sample l
- 0 acgs RL:2.0M
Man June 30, 2011 02:30:58

Jitter and Eye Diagram Analysis Tools

Description Mean i | Population Max-cc Min-cc
(e
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View test-related files

Files related to tests are stored in the SFP+ QSFP+ Tx folder under the My TekExpress shared folder.
In the SFP+ QSFP+ Tx folder, each test setup has a test setup file and a test setup folder, both with the
test setup name:

) Host_tests
v Host_tests

The test setup file is preceded by the SFP-TX icon and usually has no visible file extension.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default
is DUTO001.

Inside the DUTO001 folder are the session folders and files. Each session also has a folder and file pair, both
named for the test session using the naming convention (date) (time). Each session file is stored outside
its matching session folder:

I[)20110520_154553
I[)20110520_154713
I[Zh20110520_155111
I 20110520_155920
I[)20110520_160103
Vi 2ot 10520_154553
Vil 2ot 10520_154713
Vi zo1 10520_155111
Vi 201 10520_155920
Vi 201 10520_160103

Each session folder contains image files of any plots generated from running the test session. If you
selected to save all waveforms or ran tests using prerecorded waveform files, these are included here.

The first time you run a new, unsaved session, the session files are stored in the Untitled Session
folder located at . .\My TekExpress\SFP+ QSFP+ Tx. The session setup file is named Untitled.
When you name and save the session, the test setup file is given the name you specify and the test-related
files are placed in a folder with the same name. A copy of the test files stay in the Untitled Session folder
until you run a new test or until you close the SFP+ QSFP+ Tx application.

See also
®_File Name Extensions

m_Before You Click Start
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About the programmatic interface

The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of the TekExpress
application running on a local or a remote computer.

For simplifying the descriptions, the following terminologies are used in this section:

®  TekExpress Client: A high-level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

m  TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.

et C# Het VB HNet Web Test=tand
Client Client Chent Clhent
ry ry
‘\‘ v v /
TekEzpressChent Library
X
v
TekExpress
See also

B__Requirements for Developing TekExpress Client
B__Remote Proxy Object
®_ Client Proxy Object
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Requirements for developing TekExpress
client

88

While developing TekExpress Client, use the TekExpressClient.dll. The client can be a VB .Net, C#
.Net, TestStand or Web application. The examples for interfaces in each of these applications are in the
Samples folder.

References required

m  TekExpressClient.dT11 has an internal reference to I1d1glib.d11 and IRemoteInter-
face.dl1l.

®m I1dlglib.d11 has areference to TekDotNetLib.d11.

B IRemoteInterface.d11 provides the interfaces required to perform the remote automations. It is an
interface that forms the communication line between the server and the client.

m 11dTglib.d11 provides the methods to generate and direct the secondary dialog messages at the
client-end.

NOTE. The end-user client application does not need any reference to the above mentioned DLL files.
1t is essential to have these DLLs (IRemotelnterface.dll, 11diglib.dll and TekDotNetLib.dll) in the same
folder as that of TekExpressClient.dll.

Required steps for a client

The client uses the following steps to use TekExpressClient.d11 to programmatically control the
server:

Develop a client Ul to access the interfaces exposed through the server. This client loads
TekExpressClient.d11 to access the interfaces. After TekExpressClient.d11 is loaded, the client
UI can call the specific functions to run the operations requested by the client. When the client is up and
running, it does the following to run a remote operation:

1. To connect to the server, the client provides the IP address of the PC where the server is running.

2. The client locks the server application to avoid conflict with any other Client that may try to control
the server simultaneously. “Lock” would also disable all user controls on the server so that server
state cannot be changed by manual operation.

If any other client tries to access a server that is locked, it will receive a notification that the server
is locked by another client.

3. When the client has connected to and locked the server, the client can access any of the programmatic
controls needed to run the remote automations.

4. After the client operations finish, the client unlocks the server.
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See also
®__About SFP+ QSFP+ Tx Application Commands
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To enable remote access
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To access and remotely control an instrument using the TekExpress programmatic interface, you need to
change specific firewall settings as follows:

1. Access the Windows Control Panel and open the Windows Firewall tool (Start > Control Panel > All
Control Panel Items > Windows Firewall).

2. Click Advance Settings > Inbound Rules.
3. Scroll through the Inbound Rules list to see if the following items (or with a similar name) are shown:
- TekExpress SFP+ QSFP+ Tx

- TekExpress

ﬂ Windows Firewall with Advanced Security
Fle Acon View Help

e« |06 = HE

3 Inbound Rules Name Group | Profile  Ensbled  Action  ~
&% Outbound Rules
B4 Connection Securty Rules (@) secondary HTTP Port Al Yes Allow
» %, Monitoring (@ SimpleGpibServer Al Yes Allow
(@ simpleGpibServer All Yes Allow
(@ Status Port All Yes Allow
@ ToscsAz000 Al Yes Allow
@ TDsCsA%000 Al Yes Allow
(@ Teamviewer Remote Control Application Demain  Yes Allow |
(@ Teamviewer Remote Control Application Domain  Yes Alow |
(@ TekmDNSResponder Demain  Yes Allow
—-— K R . - . i

4. If both items are shown, you do not need to set up any rules. Exit the Windows Firewall tool.

5. If one or both are missing, use the following procedure to run the New Inbound Rule Wizard and add
these executables to the rules to enable remote access to the TekExpress application.

Run the New Inbound Rule Wizard

1. Click on New Rule (in Actions column) to start the New Inbound Rule Wizard.

I | ~ctions

Action  * || Inbound Rules -
Allow || 3 Mew Rule...

Allow T Filter by Profile »
Allow )

Allow T Fiter by State 3
Allow 7 Filter by Group >
Allow View »

2. Verify that Program is selected in the Rule Type panel and click Next.

3. Click Browse in the Program panel and navigate to and select one of the following TekExpress
applications (depending on the one for which you need to create a rule):

4. TekExpress SFP+ QSFP+ Tx.exe

5. TekExpress.exe
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To enable remote access

NOTE. See Application directories and usage for the path to the application files.

e ® 22

10.
11.

12.

13.
14.

Click Next.
Verify that Allow the connection is selected in the Action panel and click Next.
Verify that all fields are selected (Domain, Private, and Public) in the Profile panel and click Next.

Use the fields in the Name panel to enter a name and optional description for the rule. For example,
a name for the TekExpress SFP+ QSF+ Tx application could be TekExpress SFP+ QSFP+ Tx
Application. Add description text to further identify the rule.

Click Finish to return to the main Windows Firewall screen.

Scroll through the Inbound Rules list and verify that the list shows the rule that you just entered.

@ Windows Firewall with Advanced Security
File Action View Help
| 2[E =]

@ Windows Firewall with Advancd BT LT

&3 Inbound Rules Name Profile  Ensbled  Action
[ES Outbound Rules P
¥ Connection Security Rules @TDSCSMOOO All Ves Allow
B, Monitoring @ Teamviewer Remote Control Application Domain  Yes Allow
@T:amviawer Remote Control Application Domain  Yes Allow
@Tzamviewev Remote Control Service Domain  Yes Allow

@ Teamviewer Remote Control Service Domain  Yes Allow

[/ TekExpress PI Al Yes Allow
L/ TekExpress SFP+ QSFP+ Tx Al Yes Allow

@TzkmDNSRespondEr Al Yes Allow

Repeat steps 1 through 11 to enter the other TekExpress executable if it is missing from the list.
Enter TekExpress PI as the name.

Scroll through the Inbound Rules list and verify that the list shows the rule that you just entered.

Exit the Windows Firewall tool.

To use the remote access:

1.

Obtain the IP address of the instrument on which you are running TekExpress SFP+ QSFP+ Tx.
For example, 134.64.235.198.

On the PC from which you are accessing the remote instrument, use the instrument IP address as part

of the TekExpress SFP+ QSFP+ Tx PI code to access that instrument. For example:

object obj = piClient.Connect(“134.64.235.198”,0out clientid);
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Remote proxy object

92

The server exposes a remote object to let the remote client access and perform the server-side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

MarshalByEef

TekExpressClient

TekExpress RemoteProoOhiject

The following is an example:

RemotingConfiguration.RegisterwellKnownServiceType (typeof (TekExpressRe-
moteInterface), “TekExpress Remote interface”, wellkKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,
//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),
URL.ToString());
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Client proxy object

Client exposes a proxy object to receive certain information.

MarshalByRef

TekExpress [ ohipm S TekEzpressClient

For example,
//Register the client proxy object

wellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredwell-
KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterwellKnownServiceType(typeof(ClientInterface),
“Remote Client Interface”, wellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");
The client proxy object is used for the following:
B To get the secondary dialog messages from the server.
B To get the file transfer commands from the server while transferring the report.

Examples
clientObject.clientIntf.Displaybialog(caption, msg,iconType, btnType);
clientObject.clientIntf.TransferBytes(buffer, read, fileLength);

For more information, click the following topic links.
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Client proxy object

94

Secondary Dialog Message Handling

MarshalByEef
¥
Client Provxyohiject ]
TekEzpress |« TekExpressClient
Display Disbog)
Secondary Dialog

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.
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Client programmatic interface example

An example of the client programmatic interface is described and shown as follows:

Process flowchart
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Client programmatic interface example

Connect to Remote Object

'

Get Client id

'

Lock Server

'

Register for Status Change Notification

'

Select the requested tests

!

Set the necessary Patameters for each selected test

'

Run the test

Get Status

'

Status= ‘Ready’

Get Results

'

Process the Results

'

Unlock Server

'

Disconnect from Remote Object

!

Handler for Status Change Notification

No

Status = “Wait"/ “Error”

Get Status Info

Do Actions based on Status

)
Set Response

Return to Main Flow Cj

96 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



TekExpress programmatic interface Client programmatic interface example

1. Connect to a server or remote object using the programmatic interface provided.

2. Get the client ID that is created when connecting to the remote object. This client ID is one of the
required parameters to communicate with the server.

NOTE. The server identifies the client with this ID only and rejects any request if the ID is invalid.

3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the client only if the application

is locked.

4. Register for receiving notifications on status change events on the server. To register you need to
give a handler as a parameter.

NOTE. Whenever there is a change in the status of the server, all the clients registered with the server
receive a notification from the server.

Select the tests that you want to run through the programmatic interface.
Set the necessary parameters for each test.

Run the tests.

® N

Poll for the status of the application.

NOTE. Skip step 8 if you are registered for the status change notification and the status is Ready.

9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server after you complete all the tasks.

12. Disconnect from the remote object.

Handler of status change notification

1. Get the status. If the status is Wait or Error, get the information that contains the title, message
description, and the expected responses for the status.

2. Perform the actions based on the status information.

3. Set the response as expected.
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See also

B About SFP+ QSFP+ Tx Application Commands
B_Program Example
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Program example

This program example shows how to communicate between a PC and TekExpress SFP+ QSFP+ Tx
remotely.

A typical application does the following:

1.
2.

Start the application.

Connect through an IP address.
m_Client.Connect("localhost") 'True or False
clientID = m_Client.getClientID

Lock the server.
m_Client.LockServer(clientID)

Disable the Popups.
m_Client.SetVerboseMode(clientID, false)
Set the Dut ID.

m_Client.SetbutId(clientID, "DUT_Name")
Select a measurement.

mClient.SelectTest(clientID, "SFP+ Tx", "Host", "Single Ended Output
voltage Range", true)

Select a channel.

mClient.SetGeneralParameter(clientID, "SFP+ Tx", "Host", "Single Ended
Output voltage Range", "DP Connected To") 'Measurement selected

Configure the selected measurement.

mClient.SetGeneralParameter(clientiD, "SFP+ Tx", "Host", "Single Ended
Output voltage Range", "DP Connected to”) 'Single Ended Output Voltage Range
measurement selected

mClient.SetGeneralParameter(clientiD, "SFP+ Tx", "Host", "Single Ended
Output voltage Range", "DN Connected to") 'Single Ended Output Voltage Range
measurement

mClient.SetGeneralParameter(clientID, "SFP+ Tx", "Host", "Single Ended
Output Vvoltage Range", "Record Length$2M") 'Single Ended Output Voltage Range
measurement

mClient.SetAcquireParameter(clientID, "SFP+ Tx", "Host", "Single Ended
output voltage Range", "Single Ended output Voltage Range Acquisition & "$"
& "Signal Type" & "$" & PRBS21") Signal type PRB21 is selected for 'Single Ended Output
Voltage Range measurement test
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9. Run with set configurations.
m_Client.Run(clientID)

10. Wait for the test to complete.
Do
Thread.Sleep(500)
m_Client.Application_Status(clientID)
Select Case status
Case "wait"
'Get the Current State Information

mClient.GetCurrentStateIinfo(clientID, waitingMsbBxCaption, WwaitingMsbBxMes-
sage, WaitingMsbBxButtontexts)

'Send the Response

mClient.SendResponse(clientID, waitingMsbBxCaption, waitingMsbBxMessage,
waitingMsbBxResponse)

End Select
Loop Until status = "Ready"

11. After the Test is Complete.
'Save all results values from folder for current run
m_Client.TransferResult(clientID, TogDirname)
'Save all waveforms from folder for current run
m_Client.Transferwaveforms(clientiD, logDirname)
'Save all images from folder for current run

m_Client.TransferImages(clientID, TogDirname)
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12. Unlock the server.
m_Client.UnlockServer(clientID)

13. Disconnect from server.
m_Client.Disconnect()

14. Exit the application.
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About SFP+ QSFP+ Tx application commands

Click a client action below to see the command name, description, parameters, return value, and an
example, associated with the action.

Connect through an IP address

Lock the server

Disable the popups

Set or get the DUT ID

Set the configuration parameters for a suite or measurement

Query the configuration parameters for a suite or measurement

Select a measurement

Select a suite

Select a channel

Configure the selected measurement

Run with set configurations or stop the run operation

Handle Error Codes

Get or set the timeout value

Wait for the test to complete

After the test is complete

Save, recall, or check if a session is saved

Unlock the server

Disconnect from server

string id
Name Type Direction Description
id string IN Identifier of the client performing the

remote function.

Ready: Test configured and ready to start
Running: Test running
Paused: Test paused

Wait: A popup that needs your inputs

Error: An error is occurred
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string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the setup

out bool saved

Name Type Direction Description

saved bool out Boolean representing whether the
current session is saved

This parameter is used as a check in SaveSession() and SaveSessionAs() functions.

string ipAddress

Name Type Direction Description

ipAddress string IN The ip address of the server to which the client
is trying to connect to. This is required to
establish the connection between the server
and the client.

out string clientlD

Name Type Direction Description
clientid string out Identifier of the client that is connected to the
server

clientld = unique number + ipaddress of the
client. For example, 1065-192.157.98.70

NOTE. If the dutName parameter is null, the client is prompted to provide a valid DUT ID.

NOTE. The server must be active and running for the client to connect to the server. Any number of
clients can be connected to the server at a time.

NOTE. When the client is disconnected, it is unlocked from the server and then disconnected. The id
is reused.
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string dutld
Name Type Direction Description
dutld string ouTt The DUT ID of the setup

The dutld parameter is set after the server processes the request.

string device

Name Type Direction Description

device string IN Specifies the name of the device

string suite

Name Type Direction Description

suite string IN Specifies the name of the suite

string test

Name Type Direction Description

test string IN Specifies the name of the test to
obtain the pass or fail status

string parameterString

Name Type Direction Description

parameterString string IN Selects or deselects a test

int rowNr

Name Type Direction Description

rowNr int IN Specifies the zero based row index of

the sub-measurement for obtaining
the result value

from that client.

NOTE. When the client tries to lock a server that is locked by another client, the client gets a
notification that the server is already locked and it must wait until the server is unlocked. If the client
locks the server and is idle for a certain amount of time, then the server is unlocked automatically
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out string[ ] status

Name Type Direction Description

status string array out The list of status messages generated
during run

string name

Name Type Direction Description

name string IN The name of the session being
recalled

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

NOTE. When the run is performed, the status of the run is updated periodically using a timer.

string name
Name Type Direction Description
name string IN The name of the session being saved

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different
name. Use SaveSessionAs instead.

string name
Name Type Direction Description
name string IN The name of the session being

recalled

The same session is saved under different names using this method. The name parameter cannot be
empty. If it is empty, the client is prompted to provide a valid name.

bool isSelected

Name Type Direction Description

isSelected bool IN Selects or deselects a test
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string time

Name Type Direction Description

time string IN The time in seconds
which refers to the timeout
period

The time parameter gives the timeout period, that is the time the client is allowed to be locked and
idle. After the timeout period, if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to provide a valid
timeout period.

bool_verbose

Name Type Direction Description

_verbose bool IN Specifies whether the verbose mode
should be turned ON or OFF

NOTE. When the session is stopped, the client is prompted to stop the session and is stopped at
the consent.

string filePath

Name Type Direction Description

filePath string IN The location where the report must
be saved in the client

NOTE. If the client does not provide the location to save the report, the report is saved at
C:\ProgramFiles.

NOTE. When the client is disconnected, the client is unlocked automatically.

out string caption

Name Type Direction Description
caption string out The wait state or error state message sent to
you
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out string message

Name Type Direction Description
message string ouT The wait state/error state message to you

out string[] buttonTexts

Name Type Direction Description

buttonTexts string array out An array of strings containing the
possible response types that you can
send

string response

Name Type Direction Description

response string IN A string containing the response
type that can be selected (it must be
one of the strings in the string array

buttonTexts)
out string clientlD
Name Type Direction Description
clientD string ouTt Identifier of the client that is connected to the

server

clientID = unique number + ipaddress of the
client. For example, 1065-192.157.98.70
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Connect through an IP address

108

Command name Parameters Description Return Value Example

Connect() string This method Return value is m_Client = new Client()
ipAddress connects the client either True or //m_Client is a reference to the
out string to the server. False. Client class in the Client DLL.
clientlD Note returnval as boolean

The client provides
the IP address

to connect to the
server.

The server
provides a unique
client identification
number when
connected to it.

returnval = m_Client.Con-
nect(ipaddress,m_clientID)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Lock the server

Command name Parameters Description Return Value Example
LockSession() string clientlD This method locks String value m_Client = new Client()
the server. that gives the /Im_Client is a reference to the
Note status of the Client class in the Client DLL.
The client must operation after returnval as string
call this method itis performed. returnval =
before running The return value m_Client.LockServer(clientID)
any of the remote is "Session
automations. The Locked...” on
server can be success.
locked by only one
client.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Disable the popups

Disable the popups

Command name Parameters

Description

Return Value

Example

SetVerboseMode() string clientlD

bool _verbose

This method sets
the verbose mode
to either true or
false.

When the value
is set to true, any
message boxes
appearing during
the application
will be routed to
the client machine
that is controlling
TekExpress.

When the value is
set to false, all the
message boxes
are shown on the
server machine.

String that gives
the status of the
operation after it
is performed

When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog boxes
will be shown to
client”.

When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog boxes
will be shown to
server’.

m_Client = new Client()
/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string
Verbose mode is turned on

return=m_Client.SetVerbose-
Mode(clientID, true)

Verbose mode is turned off

returnval=m_Client.SetVer-
boseMode(clientID, false)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Set or get the DUT ID

Set or get the DUT ID

Command name Parameters Description Return Value Example
SetDutld() string clientlD This method String that gives m_Client = new Client()
string dutName ~ changes the DUT the status of the /lm_Client is a reference to the
ID of the set up. operation after it Client class in the Client DLL.
The client must is performed returnval as string
Bﬁ%‘?g a valid Re}urn value return=m_Client.SetDutld(clien-
' is “DUT Id tiD,desiredDutld)
Changed” on Note
success S
GetDutld() string clientlD This method gets String that gives m_Client = new Client()

string dutld

the DUT ID of the
current set up.

the status of the
operation after it
is performed

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

return=m_Client. GetDutid(clien-
tID, out Dutld)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Set the configuration parameters for a suite
or measurement

Command name

Parameters

Description

Return Value

Example

SetGeneralParame-
ter

string clientlD
string device
string suite
string test

string
parameterString

This method sets
the number of video
lanes for the selected
measurement.

NOTE. Use this
command to select
a lane, channel, or
source type.

String that gives
the status of the
operation after it is
performed

The return value is
(an empty String) on
success.

m_Client = new
Client() //m_Client
is a reference to the
Client class in the
Client DLL.
returnval as string
Select Channel

Select Measurement
Method

SetAnalyzeParame-
ter()

string clientlD
string device
string suite
string test

string
parameterString

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return value is
(an empty String) on
success.

m_Client = new
Client() //m_Client
is a reference to the
Client class in the
Client DLL .

returnval as string

SetAcquireParame-
ter()

string clientlD
string device
string suite
string test

string
parameterString

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = remo-
teObject.SetAc-
quireParameter(id,
device, suite, test,
parameterString)
if ((OP_STATUS)
returnVal !=
OP_STA-
TUS.SUCCESS)
return Command-
Failed(returnVal)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select channel example

returnval=mClient.SetGeneralParameter(clientID, "SFP-Tx", "Host", "Signal Rise/Fall Time
(20%-80%)", "Data + Signal connected to Real Time Scope at$Channel 1")

Select measurement method example

returnval=mClient.SetGeneralParameter(clientID, "SFP-Tx", "Host", "Signal Rise/Fall Time
(20%-80%)", "Measurement Method$ Automatic")

Configure analyze parameters example

Parameter Example

Record Length returnval = mClient.SetAcquireParameter(clientlD, “SFP-Tx", “Host”,
“Single Ended Output Voltage Range”, “Signal Type$PRBS31")
returnval = mClient.SetAcquireParameter(clientlD, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Record Length$2M")
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Query the configuration parameters for a suite or measurement

Query the configuration parameters for a
suite or measurement

14

Command name Parameters Description Return Value Example
GetGeneralParam- string clientlD This method The return value m_Client = new Client()
eter() string device gets the general is the general /lm_Client is a reference to the
siring suite configuration configuration Client class in the Client DLL.
—.9— parameters for parameter for returnval as string
string test a given suite or a given suite or Query Channel
string parame- measurement. measurement =uery ~hannet
terString that is set. Query Measurement Method
GetAnalyzeParam- string clientlD This method gets The return m_Client = new Client()
eter() string device the configuration value is the Im_Client is a reference to the
siring suite parameters set in configuration Client class in the Client DLL .
—.g— the Analyze tab of ~ parameter set in returnval as string
string test the Configuration the Analyze tab of
string parame- Panel dialog box the Configuration
terString for a given suite or Panel dialog box

measurement.

for a given suite
or measurement.

GetAcquireParame-
ter()

string clientlD
string device
string suite
string test

string parame-
terString

This method gets
the configuration
parameters set in
the Acquire tab for
a given suite or
measurement.

The return
value is the
configuration
parameter set

in the Acquire tab
for a given suite
or measurement.

Query Acquire Parameters
example

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Query channel example

returnval=mClient.GetGeneralParameter(clientID, "SFP-Tx", "Host", "<Test/Measurement Name>",
"DP connected to")
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Query measurement method example

returnval=mClient.GetGeneralParameter(clientID, "SFP-Tx", "Host", "<Test/Measurement Name>",
"Measurement Method")

Query acquire parameter examples

Parameter Example

Record Length returnval = mClient.GetAcquireParameter(clientID, "SFP+ TX", "Host",
"Single Ended Output Voltage Range", "Record Length$500K")
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Select a measurement

Select a measurement

116

Command name Parameters Description Return Value Example
SelectTest() string clientlD This method String that m_Client = new Client()
string device selects or displays the /Im_Client is a reference to the

string suite
string test

bool isSelected

deselects a given
test.

When this
parameter is
set to true, you
can select a
measurement.

When this
parameter is
set to false, you
can deselect a
measurement.

status of the
operation after
it is performed

The return
value is ™ (an
empty String) on
success.

Client class in the Client DLL
returnval as string

Select Measurement (Signal
Rise/Fall Time (20%-80%)):

returnval=m_Client.Se-
lectTest(clientID, "SFP-Tx",
"Host", "Signal Rise/Fall Time
(20%-80%)", true)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select a suite

Select a suite

Command name Parameters Description Return Value Example
SelectSuitet() string clientlD This method String that gives m_Client = new Client()
selects or the status of the /Im_Client is a reference to the

string device
string suite

bool isSelected

deselects a given
suite.

When this
parameter is set
to true, you can
select a suite.

When this

parameter is set
to false, you can
deselect a suite.

operation after it
is performed

The return
value is ™ (an
empty String) on
success.

Client class in the Client DLL.
returnval as string
Select Suite (Default):

returnval=m_Client.Se-
lectTest(clientID, "SFP-Tx",
"Host", true)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client”.

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select a channel

Select a channel

Command name

Parameters

Description

Return Value

Example

SetGeneralParame-
ter()

string clientlD
string device

This method sets
the parameters
that are not

String that gives
the status of the
operation after it

m_Client = new Client()
/Im_Client is a reference to the
Client class in the Client DLL.

:ﬁg%:te specific to any is performed returnval as string
sifing parame given test. Thle rgturn( Select Channel
Stng parame- NOTE. Use this value is ™ (an
terString command fo select  €mpty String) on Select Measurement Method
a lane, channel, or ~ SUCCESS.
source type.
SetAnalyzeParame-  string clientID This method sets The return m_Client = new Client()
ter() string device the configuration value is " (an /lm_Client is a reference to the
siring suite parameters in the empty String) on Client class in the Client DLL.
J—_ Analyze tab of success. returnval as string
string test the Configuration
string parame- Panel dialog box
terString for a given suite or

measurement.

SetAcquireParame-
ter()

string clientlD
string device
string suite
string test

string parame-
terString

This method sets
the configuration
parameters in the
Acquire tab of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = re-
moteObject.Se-
tAcquireParam-
eter(id, device,
suite, test, pa-
rameterString)

if (OP_STATUS)

returnVal !=
OP_STA-
TUS.SUC-

CESS) return

Command-
Failed(re-
turnVal)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select channel example

returnval=mClient.SetGeneralParameter(clientID, "SFP+ TX", "Host", "Single Ended Output Voltage
Range", "DP Connected toSCH1")

Select measurement method example

returnval=mClientSetGeneralParameter(clientID, "SFP+ TX", "Host", "Single Ended Output Voltage
Range", "Measurement Method$ Automatic")
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Configure the selected measurement

Configure the selected measurement

120

Command name Parameters Description Return Value Example
SetAnalyzeParame-  string clientID This method The return m_Client = new Client()
ter() 1 i sets the Analyze value is "™ (an /Im_Client is a reference to
W parameters empty String) on the Client class in the Client DLL.
w (Configuration success. returnval as string
string test parameters) for a
string parame- given test.
terString
SetAcquireParame- string clientlD This method returnVal = re- m_Client = new Client()
ter() string device sets the Acquire moteObject.Se- /lm_Client is a reference to
i it parameters in the tAcquireParam- the Client class in the Client DLL.
M Acquire tab of the eter(id, device, returnval as string
string test Configure Dialog suite, test, pa- Confiaure Acaire P
string parame- box for a given rameterString) ; onfigure Acquire Parameters
- or Record Length
terString test. if ((OP_STA-
TUS)
returnVal =
OP_STA-
TUS.SUC-
CESS) re-
turn Com-
mand-
Failed(re-
turnVal)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Parameter

Configure parameter example

Example

Record Length

returnval = mClient.SetAcquireParameter(clientID, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Signal Type$PRBS31")

returnval = mClient.SetAcquireParameter(clientlD, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Record Length$2M")
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Run with set configurations or stop the run

operation

Command name Parameters Description Return Value Example

Run() string clientlD Runs the selected String that gives m_Client = new Client()
tests. Note the status of the /Im_Client is a reference to the
After the server operation after it Client class in the Client DLL.
is set up and is performed returnval as string
configured, run The return value returnval=m_Client.Run(clien-
it remotely using is "Runstarted.."  {p) B
this function. 0N success.

Stop() string clientlD Stops the currently String that gives m_Client = new Client()

running tests Note

the status of the
operation after it
is performed.

The return value
is "Stopped..." on
success.

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.Stop(clien-
tiD)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Handle error codes

The return value of the remote automations at the server-end is OP_STATUS, which changes to a string
value depending on its code and returned to the client. The values of OP_STATUS are as follows:

Value Code Description

FAIL -1 The operation failed.

SUCCESS 1 The operation succeeded.

NOTFOUND 2 Server not found

LOCKED 3 The server is locked by another client, so the operation cannot
be performed.

UNLOCK 4 The server is not locked. Lock the server before performing
the operation.

NULL 0 Nothing
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Get or set the timeout value

Get or set the timeout value

Command name Parameters Description Return Value Example
GetTimeOut() string clientlD Returns the current String that gives m_Client = new
timeout period setby  the status of the Client() //m_Client
the client operation after it is is a reference to the
performed Client class in the
The default return Client DLL.
value is 1800000. returnval as string
return-
val=m_Client.Get-
TimeOut()
SetTimeOut() string clientlD Sets a timeout String that gives m_Client = new

string time

period specified
by the client.
After this timeout
period expires, the
server is unlocked
automatically.

the status of the
operation after it is
performed

On success the
return value is
“TimeOut Period
Changed”.

Client() //m_Client
is a reference to the
Client class in the
Client DLL.

returnval as string
return-
val=m_Client.Set-

TimeOut(clientID,
desiredTimeOut)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Wait for the test to complete

124

The commands in this group execute while tests are running. The GetCurrentStatelnfo() and
SendResponse() commands are executed when the application is running and in the wait state.

Command name Parameters Description Return Value Example
ApplicationStatus() string clientlD This method gets the String value that ~ m_Client = new Client()
status of the server gives the status IIm_Client is a reference to the
application. of the server Client class in the Client DLL.
The states at a given application returnval as string
time are Ready, returnval=m_Client.Applica-
Running, Paused, tionStatus(clientID)
Wait, or Error.
QueryStatus() string clientlD An interface for String that gives ~ m_Client = new Client()
out string[] the user to transfer the status of the  //m_Client is a reference to the
status Analyze panel status operation afterit  Client class in the Client DLL.

messages from the
server to the client.

is performed

On success the
return value is
“Transferred...”.

returnval as string
returnVal=m_Client.QueryS-
tatus(clientID, out statusMes-
sages)
if ((OP_STATUS)returnVal ==
OP_STATUS.SUCCESS)
return “Status updated...”
else

return CommandFailed(re-
turnVal)
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Wait for the test to complete

Command name Parameters Description Return Value Example

GetCurrentState- string clientlD This method gets the This command m_Client = new Client()

Info() out string additional information does not return /lm_Client is a reference to the

NOTE. This caption of the states when the  any value. Client class in the Client DLL.
- - application is in Wait - This function m_Client.GetCurrentState-

command is out string o Error state ; \

used when the message hi populates the Info(clientID, caption,mes-

application is out string] Except client ID, all Out parameters sage, buttonTexts)

running and is in buttonTexts the others are Out that are passed

the wait or error
state.

parameters.

when invoking
this function.

SendResponse()

NOTE. This
command is
used when the
application is
running and is in
the wait or error
state.

string clientlD

out string
caption

out string
message

string response

After receiving the
additional information
using the method
GetCurrentState-
Info(), the client de-
cides which response
to send, and then
sends the response to
the application using
this function. The
response should be
one of the strings that
was received earlier
as a string array in the
GetCurrentStatelnfo
function. The _cap-
tion and _message
should match the in-
formation received
earlier in the GetCur-
rentStatelnfo function.

This command
does not return
any value.

m_Client = new Client()
/Im_Client is a reference to the
Client class in the Client DLL.

m_Client.SendResponse(cli-
entID, caption,message,
response)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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After the test is complete

Command name

After the test is complete

Parameters

Description

Return Value

Example

GetPassFailSta-
tus()

string clientlD
string device
string suite
string test

This method gets
the pass or fail
status of the
measurement after
test completion.

NOTE. Execute
this command
after completing
the measurement.

String that gives
the status of the
operation after it
is performed

Returns the pass
or fail status in the
form of a string

m_Client = new Client()
/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.GetPass-
FailStatus(clientlD, device,
suite, "Signal Rise/Fall Time
(20%-80%)") //Pass or Fail

GetResultsValue() string clientlD This method gets String that gives m_Client = new Client()
string device the result values of  the status of the /Im_Client is a reference to the
strina suite the measurement operation after it Client class in the Client DLL.
z:: teasrtame- Retumns the result  returnval=m_Client.GetRe-
FS%E— value in the form sultsValue(clientID, "SFP-TX",
fersting of a string "Host", "Signal Rise/Fall Time
0-80%)", "Measured Value
(20%-80%)", "M d Value")
GetResultsValue- string clientlD This method gets String that gives m_Client = new Client()
ForSubMeasure- string device the result values the status of the /Im_Client is a reference to the
ments() string suite for individual sub- operation after it Client class in the Client DLL.
—‘g— measurements is performed returnval as string
string fest after the run. Retums the result  sjgnal Rise/Fall Time
string parame- value in the form A
terString of a strin returnval=m_Client.GetRe-
int rowNr g sultsValueForSubMeasure-

ments(clientID, "SFP-Tx",
"Host", "Signal Rise/Fall
Time (20%-80%)", "Measured
Value",0) //For DP wfm

returnval=m_Client.GetRe-
sultsValueForSubMeasure-
ments(clientID, "SFP-Tx",
"Host", "Signal Rise/Fall
Time (20%-80%)", "Measured
Value",1) //For DN wfm
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After the test is complete

Command name Parameters Description Return Value Example
GetReportParame- string clientlD This method The return m_Client = new Client()
ter() string device gets the general value is the /lm_Client is a reference to the
string suite report details such oscilloscope Client class in the Client DLL.
—.g— as oscilloscope model, returnval as string
string test model, TekExpress Oscilloscope Model
string parame- TekExpress version, and P _
terString version, and SFP+ QSFP+Tx  returnval=m_Client.GetRe-
SFP+ QSFP+ Tx version. portParameter(clientlD,"Scope
version. Model")
TekExpress Version
returnval=m_Client.GetReport-
Parameter(clientID,"TekExpress
Version")
SFP+ QSFP+ Tx Version
returnval=m_Client.GetReport-
Parameter(clientID,"Application
Version")
TransferReport() string clientlD This method String that gives m_Client = new Client()
string filePath transfers the report  the status of the /lm_Client is a reference to the
generated after the operation after it Client class in the Client DLL.
run. is performed returnval as string
The report Transfers all the returnval=m_Client. TransferRe-

contains the
summary of the
run.

The client must
provide the
location where
the report is to
be saved at the
client-end.

result values in
the form of a
string

port(clientlD,"C:\Report”)
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TekExpress programmatic interface

After the test is complete

Command name Parameters Description Return Value Example
TransferWave- string clientlD This method String that gives m_Client = new Client()
forms() string filePath transfers all the the status of the IIm_Client is a reference to the

waveforms from
the folder for the
current run.

NOTE. Each
time you click
Start, a folder is
created on the X:

operation after it
is performed

Transfers all the
waveforms in the
form of a string

On success the
return value is

Client class in the Client DLL.
returnval as string

returnval=m_Client.Transfer-
Waveforms(clientlD,"C:\Wave-
forms”)

drive. Transfer the “Transferred...”
waveforms before
clicking Start..
Transferimages() string clientlD This method String that gives m_Client = new Client()

od
string filePath

transfers all the
images (screen
shots) from the
folder for the

current run (for
a given suite or
measurement).

NOTE. Each
time you click
Start, a folder is
created in the X:
drive. Transfer the
waveforms before
clicking Start.

the status of the
operation after it
is performed

Transfers all the
images in the
form of a string

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.Transferim-
ages(clientID, "C:\Waveforms”)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

String parameterString

Name Type

Direction

Description

parameterString string

IN

Specifies the oscilloscope
model, TekExpress version, and
SFP+ QSFP+ Tx version.
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TekExpress programmatic interface

Save, recall, or check if a session is saved

Save, recall, or check if a session is saved

Command name Parameters Description Return Value Example

CheckSession- string clientlD This method Return value is m_Client = new Client()

Saved() out bool saved checks whether either True or /lm_Client is a reference to the
the current session False Client class in the Client DLL.
is saved.

returnval as string

returnval=m_Client.Check-
SessionSaved(m_clientID, out
savedStatus)

RecallSession()

string clientlD
string name

Recalls a saved
session. The
client provides

String that gives
the status of the
operation after it

m_Client = new Client()
/Im_Client is a reference to the
Client class in the Client DLL.

the session name. is performed returnval as string
The retun value  retymval=m_Client.RecallSes-
is “Session sion(clientID, savedSession-
Recalled...”. Name)
SaveSession() string clientlD Saves the current String that gives m_Client = new Client()
string name session. The the status of the IIm_Client is a refergnce to the
client provides operation after it Client class in the Client DLL.
the session name. is performed returnval as string
The return value returnval=m_Client.SaveSes-
is "Session Sav- sion(clientID, desiredSession-
ed...""Failed...". Name)
SaveSessionAs() string clientlD Saves the current String that gives m_Client = new Client()

string name

session under a
different name
every time this
method is called.

The client provides

the session name.

the status of the
operation after it
is performed

The return value
is "Session
Saved...".

/Im_Client is a reference to the
Client class in the Client DLL.
returnval as string

returnval=m_Client.SaveSes-
sionAs(clientID, desiredSes-
sionName)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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TekExpress programmatic interface Unlock the server

Unlock the server

Command name Parameters Description Return Value Example

UnlockSession() string clientlD This method String that gives m_Client = new Client()
unlocks the server the status of the //m_Client is a reference to the
from the client. operation after it Client class in the Client DLL.
The ID of the client is performed returnval as string
o be unlocked The return value =m Cli
must be provided. s "Session returnval=m_Client.Unlock-

Server(clientlD
Note Un-Locked...". ( )

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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TekExpress programmatic interface

Disconnect from the server

Disconnect from the server

Command name Parameters Description Return Value Example
Disconnect() string clientlD This method Integer value m_Client = new Client()

disconnects the
client from the
server.

Note

that gives the
status of the

operation after
it is performed
1 for Success

-1 for Failure

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.Discon-
nect(m_clientID)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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TekExpress programmatic interface Disconnect from the server
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SFP+ QSFP+ Tx tests Disconnect from the server
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SFP+ QSFP+ Tx tests

Signal types used by tests

Signal types used by tests

The following tables list the signal types used by each measurement for the two profiles.

Host profile

Table 14: Host profile measurement signal types

Measurement Compliance mode support User-Defined Mode support

Single Ended Output Voltage Range PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Output AC Common-Mode Voltage PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,

(RMS) PRBS20, PRBS23, PRBS31

Cross Talk Source Rise/Fall Time 8180 PRBS7, PRBS9, PRBS11, PRBS15,

(20%-80%) PRBS20, PRBS23, PRBS31, 8180

Cross Talk Source Amplitude (p-p) 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Signal Rise/Fall Time (20%-80%) 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Total Jitter PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Total Jitter @ J2 PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Total Jitter @ J9 PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Data Dependent Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Data Dependent Pulse Width PRBS9 PRBS7, PRBS9, PRBS11, PRBS15

Shrinkage (DDPWS)

Uncorrelated Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Transmitter Qsq 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Eye Mask Hit Ratio PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Voltage Modulation Amplitude (p-p) 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Transmitter Qsq (for Cu) 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Output AC Common Mode Voltage PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,

(RMS) (for Cu) PRBS20, PRBS23, PRBS31

Host Output TWDPc PRBS9 PRBS9
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SFP+ QSFP+ Tx tests

Signal types used by tests

Module profile

Table 15: Module profile measurement signal types

Measurement Compliance mode support

User-defined mode support

AC Common Mode Voltage Tolerance PRBS31

PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Single Ended Input Voltage Tolerance PRBS31

PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Cross Talk Source Rise/Fall Time 8180 PRBS7, PRBS9, PRBS11, PRBS15,

(20%-80%) PRBS20, PRBS23, PRBS31, 8180

Cross Talk Source Amplitude (p-p) 8180 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31, 8180

Output AC Common-Mode Voltage PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,

(RMS) PRBS20, PRBS23, PRBS31

Total Jitter PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Total Jitter @ J2 PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Total Jitter @ J9 PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Data Dependent Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Data Dependent Pulse Width PRBS9 PRBS7, PRBS9, PRBS11, PRBS15

Shrinkage (DDPWS)

Uncorrelated Jitter PRBS9 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

Eye Mask Hit Ratio PRBS31 PRBS7, PRBS9, PRBS11, PRBS15,
PRBS20, PRBS23, PRBS31

See also

®_Signal Validation Procedure
m_ Select Acquisitions
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SFP+ QSFP+ Tx tests Oscilloscope setup

Oscilloscope setup

The following tables show the generalized oscilloscope setup parameters for all tests, except where noted.

Table 16: Horizontal setup

Mode Sample Rate Record Length Acquisition Mode
Manual 100 GS/s 5M, 10M 100 GS/s

Table 17: Vertical setup

Channel 1 Channel 2

Position Scale Offset Position Scale Offset

0 Vertical setup 0 0 Vertical setup 0
procedure procedure

See also

B_Signal Validation Procedure
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SFP+ QSFP+ Tx tests Signal validation procedure

Signal validation procedure

Each measurement goes through signal validation, signal acquisition, and measurement steps. Before
running any measurement, check the signal for validity. To do this, set up the oscilloscope to acquire the
signal and then test the signal for its characteristics such as voltage level and/or frequency. Once the
characteristics of the signal are correct, the signal is valid and ready for use in compliance measurements.
The signal validation procedure is the same for both Host and Module Profile measurements.

SFP+ solution supports three types of signals: PRBS9, PRBS31, and 8180.

NOTE. PRBS20, PRBS23, PRBS31 pattern validation is not done. The signal is assumed to be PRBS20,
PRBS23, or PRBS31 respectively.

Acquire the signal according to the SFF-8431 specification. The oscilloscope setup differs for each
measurement. For all measurements, use the following guidelines to set up the oscilloscope. For the
oscilloscope setup for individual tests, see the individual test topics.

After the signal is acquired, the measurement is conducted using either the base oscilloscope, DPOJET,
or the TekExpress algorithm library.

Oscilloscope setup guidelines

The following describes the oscilloscope setup and signal validation measurement for PRBS7, PRBS9,
PRBS11, PRBS15, and 8180 signals.

1. Connect the input signal to the appropriate channels. (The channels are those selected as data sources
in the Acquisitions tab of the Setup panel.)

The vertical setup routine runs automatically to find the best fitting vertical scale.
Horizontal setup uses these parameters:
= Mode: Manual
= Sample Rate: 100 GS/s
- Record Length: SM/10M
= Acquisition Mode: Sample
2. On the oscilloscope, set Mathl = (Ch1 — Ch3).
3. Call the Signal Validation algorithm to verify the signal type.

The signal validation results are returned from the algorithm. If signal validation fails, display a
signal validation message.
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SFP+ QSFP+ Tx tests Signal validation procedure

See also

B_QOscilloscope Setup
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SFP+ QSFP+ Tx tests Single-ended output voltage range

Single-ended output voltage range

Single-ended output voltage range is measured as the single-ended peak-to-peak output voltage for the
positive and negative data channels on a single acquisition. This test is one of the SFF-8431 Table 11
Output Electrical Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Single-ended output voltage range is measured using base DPOJET.

m  Use DPOJET measurement name: Ampl > Max and Ampl > Min for Dp and Dn

Limits
For each of Dp and Dn: Minimum = —0.3 V; Maximum =4 V

Snapshot and cursor placement details
There will be two snapshots:

A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dp. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dp.

B A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-PK
measurement value of Dn. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dn.

See also

B_ QOscilloscope Setup

B Common Test Parameters and Values
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SFP+ QSFP+ Tx tests Output AC Common-Mode voltage (RMS) (Host)

Output AC Common-Mode voltage (RMS)
(Host)

140

Output AC common-mode voltage is measured as the AC RMS voltage of the common mode ((DP+DN) +
2) signal. This test is one of the SFF-8431 Table 11 Output Electrical Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Output AC common-mode voltage is measured using the base oscilloscope.
1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose
Histogram Vertical.

3. Select Mathl as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits

Maximum = 15 mV

Snapshot and cursor placement details

A snapshot where the histogram on math and the standard deviation value of the histogram is visible on
the screen. The standard deviation value visible on the screen should be the value reported in the report.
No cursors are required.

See also

m_Oscilloscope Setup

B Common Test Parameters and Values
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SFP+ QSFP+ Tx tests Crosstalk source Rise/Fall time (20% - 80%) (Host)

Crosstalk source Rise/Fall time (20% - 80%)
(Host)

Crosstalk source rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of
VMA) Fall time of the differential Crosstalk Source introduced to the signal. This test is one of the
SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: Table 12 Crosstalk
Source Tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The crosstalk source rise/fall time measurement is performed using the algorithm library.

Inputs to algorithm

m  Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying
12 GHz filter

®  Signal Type ("SFPPlus.SignalType")

Algorithm
m  [nput the differential waveform.

B Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns
found in the waveform).

= Find the position of the rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (=
End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).

m  On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (=
Start) and traverse forward until the first point crossing the lower limit (20%) is found (= End).

B Transition time is computed as TT = (End — Start). This value is averaged across all edges.

m  End

Limits

Target value = 34 ps
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SFP+ QSFP+ Tx tests Crosstalk source Rise/Fall time (20% - 80%) (Host)

Snapshot and cursor placement details

This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors
placed at the fall time.

B Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

B Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge, cursor2 =
ending point of FT of first falling edge.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values

142 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



SFP+ QSFP+ Tx tests Crosstalk source amplitude (p-p differential) (Host)

Crosstalk source amplitude (p-p differential)
(Host)

Crosstalk source amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential crosstalk source introduced to the signal. This test is one of the SFF-8431
Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: Table 12 Crosstalk
Source Tests.

Signal validation

For compliance, perform®Signal Validation Procedure.

Measurement procedure

The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying
12 GHz filter

Algorithm

B [nput the differential waveform.

B On the input waveform, identify the regions with the pattern 11111111 or 00000000.
B On each such pattern, measure the mean voltage in the middle 20% of the pattern.

B The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

B The required result Amplitude is given by, Amplitude = vHigh — vLow.
®  FEnd
Limits

Target value = 1000 mV
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SFP+ QSFP+ Tx tests Crosstalk source amplitude (p-p differential) (Host)

Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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SFP+ QSFP+ Tx tests Signal Rise/Fall time (20% - 80%)

Signal Rise/Fall time (20% - 80%)

Signal rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of VMA) Fall time
of the input signal. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The signal rise/fall time (20% — 80%) measurement is performed using the algorithm library.

Inputs to algorithm

®  Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying
12 GHz filter

B Signal Type ("SFPPlus.SignalType")

Algorithm

B Obtain values of vHigh and vLow as done in the “VMA” measurement. (Averaged over all the
patterns found in the waveform.)

B Find the position of rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found
(=End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).

B On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found
(=Start) and traverse forward until the first point crossing the lower limit (20%) is found (=End).

B Compute Transition Time, TT = (End — Start) This value is averaged across all edges.

® FEnd

Limits
Minimum value = 34 ps

Snapshot and cursor placement details

This measurement has two snapshots: first with cursors placed at the rise time, second with cursors
placed at the fall time.
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SFP+ QSFP+ Tx tests Signal Rise/Fall time (20% - 80%)

B Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

m  Fall time: Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge,
cursor2 = ending point of FT of first falling edge.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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SFP+ QSFP+ Tx tests Total jitter (Host)

Total jitter (Host)

TJ, as used here, is the Level 1 definition for Total Jitter as described in the FC-MJSQ, where TJ is the
crossing width, defined as the late time at which the BER is 10-12 minus the early time at which the BER is
10-12. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Total jitter is measured using base DPOJET.
B Deskew the Data+ and Data- inputs. Compute the differential signal on Mathl = Dp — Dn.

m  Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single-ended
input signals.

DPOJET settings
m  Select Tab: Select Jitter > TJ@BER.
- Configure the source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp — Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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Total jitter (Host)
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Configure Tab:

Edges: Signal Type = Data
Clock Recovery:
= Method = PLL Custom BW
= PLL Model = Type 11
= Damping = 700 m
- Loop BW =4 MHz
= Click the Advanced Button:
- Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
RjDj:
For PRBS9 signal:
= Pattern Type = Repeating
= Pattern Length = 511 UI
= BER 1E-=12 (for J2 BER 1E- = 2.6; for ]9 BER 1E- = 9.6)
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12 (for J2 BER 1E- = 2.6; for J9 BER 1E- =9.6)
Filters: No filters
General: OFF
Global:
= Gating: OFF
= Quality: OFF
- Population: OFF

Results Tab: In the Options menu, deselect Display Units — Absolute.
Click Single.
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SFP+ QSFP+ Tx tests Total jitter (Host)

Limits

Maximum value = 0.28 Ul

Snapshot and cursor placement details

No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom
a part of the waveform to see the type of waveform used for the measurement. Zoom the waveform
between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in the
zoomed part will be 200.

See also

B_ QOscilloscope Setup

®__Common Test Parameters and Values
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SFP+ QSFP+ Tx tests Data dependent jitter (Host)

Data dependent jitter (Host)

DDJ is the range (max — min) of the timing variations measured on the Differential Signal with a crossing
level equal to the average value of the entire waveform being measured. The waveform is averaged
sufficiently to remove the effects of random jitter and noise in the system. This test is one of the SFF-8431
Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure
Data dependent jitter is measured using base DPOJET.
B Deskew the Data+ and Data- inputs. Compute the differential signal on Mathl = Dp — Dn

m  Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended
input signals.

DPOJET settings
m  Select Tab: select Jitter, click DDJ.
= Source configuration:
= Source = Math 1 (Dp — Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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SFP+ QSFP+ Tx tests

Data dependent jitter (Host)

®  Configure Tab:
= Clock Recovery:
= Method = PLL-Custom BW
= PLL Model = Type 11
= Damping =700 m
= Loop BW =4 Mhz
= Click the Advanced button:
= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
- Click OK.
= RjDj:
For PRBS9:
= Pattern Type = Repeating
= Pattern Length = 511 Ul
= BER 1E-=12
For PRBS31:
= Pattern Type = Arbitrary
=  Window Length = 10 UI
= Population = 100
= BER 1IE-=12
= Filters: No filters
= General: OFF
= Global:
= Gating: OFF
= Quality: OFF
= Population: OFF
m  Results Tab: In the Options menu, deselect Display Units — Absolute.
B Click Single.

Limits

Maximum value = 0.10 Ul
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Snapshot and cursor placement details

No cursors are required because data dependent jitter cannot be shown using cursors or snapshots.
Instead, zoom a part of the waveform to see the type of waveform used for the measurement. Zoom the
waveform between time 0 and (horizontal scale + 104). If the record length is 2M, the number of points in
the zoomed part will be 200.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Data dependent pulse width shrinkage (Host)

DDPWS is measured as the difference between one symbol period and the minimum of all the differences
between pairs of adjacent edges on the differential signal with a crossing level equal to the average value
of the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of
random jitter and noise in the system. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask
Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Data+ and Data— after deskewing.

Algorithm

®  [nput differential waveform.

m  Estimate the Ul of the waveform (UI = bit duration).

®  [dentify all the PRBS9 patterns found in the acquired signal.

E  Overlap all the PRBS9 patterns found in the acquisition to get a single averaged PRBS9 pattern.

B [dentify the minimum width between adjacent edges of the averaged PRBS9 pattern. [= minimum UI]

B Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated Ul — minimum
UL

Limits

Maximum value = 0.055 Ul

Snapshot and cursor placement details

This measurement has one zoomed snapshot with cursorl and cursor2 marking the smallest UI.
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See also

B_QOscilloscope Setup

B Common Test Parameters and Values
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Uncorrelated jitter (Host)

Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the
transmitter data. The uncorrelated jitter (rms) is given by the RMS value of the standard deviations of the
two distributions, namely standard deviation of jitter on rising edge and standard deviation of jitter on
falling edge. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The uncorrelated jitter measurement is performed using the algorithm library.

Inputs to algorithm
B Differential waveform obtained on a Math channel using Data+ and Data— after deskewing

m  Signal Type ("SFPPlus.SignalType")

Algorithm
B Input differential waveform.

m Identify the deviation of each rising and falling edge on the input signal from its ideal location
(constructed using Ul = 1+ data rate) (Note: consider the rising and falling edges of a pattern with the
longest run of 1s to maintain some uniformity on the edges to measure deviations. If the deviations
were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

B Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the
deviation of the falling edges.

[
=vN(o,+ 0/ )12

where o, is the standard deviation of the jitter on the rising edge

B Compute UJ as follows:

Uncorrelated jitter (rms):

where o is the standard deviation of the jitter on the falling edge

®  End
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Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = UJ.Mean

Limits
Maximum value = 0.023 Ul

Snapshot and cursor placement details

No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of the
waveform to see the type of waveform used for the measurement. Zoom the waveform between time 0 and
(horizontal scale + 104). If the record length is 2M, the number of points in the zoomed part will be 200.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Transmitter Qsq

Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). This test
is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The transmitter Qsq measurement is performed using the algorithm library.

Inputs to algorithm

m  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing
®  Signal Type ("SFPPlus.SignalType");

B Window Width (“SFPPlus.QsqWidth”);

Algorithm
®  [nput differential PRBS waveform

B Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the
pattern 11111111 or 00000000.

B On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is
the flattest.

B  The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

.2 .2
. . . levelONE; + LevelZERO /2
LevelZERONoise. Noise (rms) is measured as: \/( ove rowe TLeve noise”)

_ 2% Noise(rms)

B Measure Relative Noise as: VMA
The required result Tx Qsq is given by Tx Qsq =1 + RN
®m  End

Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = TxQsq.Mean
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m_SFPPlusISDB. HistlLeft.Value = LevelONEnoise window begin

m_SFPPlusISDB. Hist1Right.Value = LevelONEnoise window end
m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom for LevelONEnoise
m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set for Level ONEnoise
m_SFPPlusISDB. Hist2Left.Value = LevelZEROnoise window begin

m_SFPPlusISDB. Hist2Right.Value = LevelZEROnoise window end
m_SFPPlusISDB.HorizontalPos2.Value = position of the waveform where to zoom for LevelZEROnoise

m_SFPPlusISDB.HorizontalScale2.Value = scale of Zoom that is to be set for LevelZEROnoise

Limits

Minimum value = 50

Snapshot and cursor placement details

This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first
snapshot has cursorl and cursor2 marking the flattest region of the high part of the period. The second
snapshot has cursorl and cursor2 marking the flattest region of the low part of the period.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Eye mask hit ratio (Host)

The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter

eye diagram (used to measure the number of Mask Hits). Eye mask hit ratio is computed using eye mask
hit ratio = (Number of Mask Hits x Signaling Speed) + (Number of Uls x Sampling rate). This test is one
of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.
B Deskew the Datat+ and Data— inputs. Compute the differential signal on Math1 = Dp — Dn.

m  Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended
input signals.

DPOJET settings
m  Select Tab: Select Eye >Mask Hits.
= Configure the Source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp—Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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®  Configure Tab:
= Edges: Signal Type = Data
= Clock Recovery:
= Method = PLL — Custom BW
= PLL Model = Type 11
= Damping =700 m
= Loop BW =4 MHz
= Click the Advanced button:
= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
= Click Apply.
= RjDIJ:
For PRBS9 signal:
= Pattern Type = Repeating
= Pattern Length = 511 UI
= BER 1E-=12
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12
- Filters: No filters
= General: OFF
= Global:
= QGating = OFF
= Quality = OFF
- Population = OFF
B (Click Run.

NOTE. Run until population crosses 2M.
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The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following
formula to obtain the Mask Hit Ratio:

Mask Hit Ratio = Number of Mask Hits x Signaling Speed (10.3125 ¢9) + Number of Uls (Population
from DPOJET) x Sampling Rate (50 ¢9)

Limits

Mask hit ratio of 5 x 10-5

Snapshot and cursor placement details

This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.

See also

m_ Oscilloscope Setup

B Common Test Parameters and Values
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Voltage modulation amplitude (p-p)

162

Voltage modulation amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential data signal. This test is one of the SFF-8431 Table 33 Output Specifications
at B for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform mSignal Validation Procedure.

Measurement procedure

The voltage modulation amplitude (p-p) measurement is performed using the algorithm library.

Inputs to algorithm
B Differential waveform obtained on a Math channel using Data+ and Data— after deskewing

m  Signal Type ("SFPPlus.SignalType")

Algorithm

B [nput differential PRBS waveform.

®  On the input waveform identify the regions with the pattern 11111111 or 00000000.
®  On each such pattern measure the mean voltage in the middle 20% of the pattern.

B The mean voltages corresponding to the Signal High regions is taken as vHigh and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

B The required result VMA is given by, VMA = vHigh — vLow
®  End

Limits

Minimum value = 300 mV

Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.
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See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Transmitter Qsq (for Cu)

164

Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). RN
is measured as RN = 2 x Noise (rms) + VMA. And Noise(rms) = Sq rt ( (LogicONENoise(rms)2 +
LogicZERONoise(rms) 2 ) = 2 ). This test is one of the SFF-8431 Table 33 Output Specifications at B
for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform BSignal Validation Procedure.

Measurement procedure

The transmitter Qsq (for Cu) measurement is performed using the algorithm library.

Inputs to algorithm
®  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing

m  Signal Type ("SFPPlus.SignalType");

Algorithm
= Input differential PRBS waveform

B Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the
pattern 11111111 or 00000000.

B On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is
the flattest.

B  The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

: . levelONEnoise “+ LevelZEROnoise” )/2
LevelZERONoise. Measure Noise (rms) as: \/(eve rowe TLeve noise” )/

2 )
RN = * Noise(rms)

B  Measure Relative Noise as: VMA
The required result TxQsq is given by TxQsq =1+ RN
®m End

Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = TxQsq.Mean
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Limits

Minimum value = 63.1

Snapshot and cursor placement details

This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first
snapshot has cursorl and cursor2 marking the flattest region of the high part of the period. The second
snapshot has cursorl and cursor2 marking the flattest region of the low part of the period.

See also

B_ QOscilloscope Setup

B Common Test Parameters and Values
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Output AC Common-Mode voltage (RMS) (for

Cu)

166

Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP + DN)
+ 2) signal. This test is one of the SFF-8431 Table 33 Output Specifications at B for Cu tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure

The output AC common-mode voltage (RMS) (for Cu) measurement is performed using the base
oscilloscope.

1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from top left of the oscilloscope to the bottom right and choose
Histogram Vertical.

3. Select Mathl as the histogram source.
4. From the Measurement menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits

Maximum = 12 mV

Snapshot and cursor placement details

A screen shot where the histogram on math and the standard deviation value of the histogram is visible
on the screen. The visible standard deviation value should be the value shown in the report. No cursors
are required.

See also

B_Oscilloscope Setup

B Common Test Parameters and Values
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Host output TWDPc

NOTE. The Host Output TWDPc test is supported only on oscilloscopes that support 100 Gs/s. For
details, see Compatibility.

TWDP is a measure of the deterministic dispersion penalty due to a particular transmitter with reference
emulated multi-mode fibers and receiver. TWDP is initially defined to characterize the performance of
a transmitter in optical links. The same concept has been extended to quantify channel performance,
especially in high-speed copper links.

This test is one of the SFF-8431 Revision 4.1 Table 33-Host Transmitter Output Specifications at B
for Cu tests.

NOTE. The TWDPc measurement is supported only on a Ch1—Ch3 combination setup of a C or D series
oscilloscope. 100 GS/s RT mode output on Ch2 and Ch4 is not available. Therefore, if Chl is not working,
the test cannot be performed successfully.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests: All other Host tests.

Signal validation

For compliance, perform mSignal Validation Procedure.

Measurement procedure

The Host output TWDPc measurement is performed using the algorithm library.

Inputs to algorithm

®  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing. Sampled
at 3.3 TS/s using IT mode.

m  Signal Type (“SFPPlus.SignalType”);

Algorithm
®  Input the differential waveform (sampled at 3.3 TS/s IT)
m  Down sample the differential input waveform to 16 samples per UI (which is down sampling 20 times)

B Identify all the PRBS9 patterns in the waveform. For each PRBS9 pattern, write all points to a text file
and call the SFF8431 x WDP algorithm.
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B The required result TWDPc is the average value of the TWDP calculated for each PRBS9 pattern.

® End

Output from algorithm

m_SFFPlusISDB.Result] Mean. Value = Average TWDPc value

Limits

Maximum value = 10.7 dBe

See also

B_QOscilloscope Setup

B Common Test Parameters and Values
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AC Common-Mode voltage tolerance
(Module)

Output AC common-mode voltage tolerance is measured as the AC RMS voltage of the common mode
((DP+DN)=2) signal. This is one of the SFF-8431 Revision 4.1 Table 16 Module Transmitter Input
Electrical Specifications at B' tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests: All other Module
tests.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application.
The software assumes that the PRBS31 pattern is valid.

Measurement procedure
AC common-mode voltage tolerance is measured using the base oscilloscope.

1. Generate the AC common-mode waveform on Mathl = (Dp + Dn) + 2. Switch off the channels
connected to Dp and Dn.

2. Add the base oscilloscope measurement Min and Max. Choose Mathl as the source in both cases.

3. Perform a single run and read the Min and Max values.

Limits
Min (Abs(Min), Abs(Max)) > 15 V (Table 16)

Snapshot and cursor placement details

A snapshot of the common-mode voltage is displayed on the oscilloscope.

See also

B_ QOscilloscope Setup

®__Common Test Parameters and Values
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Single-Ended input voltage tolerance
(Module)

Single-ended input voltage tolerance is measured as the single-ended peak-to-peak input voltage for the
positive and negative data channels on a single acquisition. This test is one of the SFF-8431 Revision 4.1
Table 16 Module Transmitter Input Electrical Specifications at B’ tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: Single-Ended
Input Voltage Tolerance Test.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application.
The software assumes that the PRBS31 pattern is valid.

Measurement procedure

Single-ended input voltage tolerance is measured using base DPOJET.
®  Use DPOJET measurement name: Ampl > Cycle Pk-Pk

B Use DPOJET settings: All default settings

Limits
For each of Dp and Dn:
Minimum = -0.3 V

Maximum =4 V
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Snapshot and cursor placement details
There will be two snapshots:

B A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dp. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dp.

B A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dn. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dn.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Crosstalk source Rise/Fall time (20% - 80%)
(Module)

172

Crosstalk source rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of
VMA) Fall time of the differential crosstalk source introduced to the signal. This test is one of the
SFF-8431 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests: All other Module
tests.

Signal validation

For compliance, perform BSignal Validation Procedure.

Measurement procedure

The crosstalk source rise/fall time (20% — 80%) measurement is performed using the algorithm library.

Inputs to algorithm

= Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying
12 GHz filter

®  Signal Type ("SFPPlus.SignalType")

Algorithm
®  Input differential waveform.

B Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns
found in the waveform).

®m  Find the position of rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (=
End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).

m  On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (=
Start) and traverse forward until the first point crossing the lower limit (20%) is found (= End).

B Transition time is computed as TT = (End — Start). This value is averaged across all edges.

m End

Limits

Target value = 34 ps
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Snapshot and cursor placement details

This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors
placed at the fall time.

B Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

m  Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge, cursor2 =
ending point of FT of first falling edge.

Cursor values and zoom positions are provided by the Algorithm library.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Crosstalk source amplitude (p-p differential)
(Module)

174

Crosstalk source amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential crosstalk source introduced to the signal. This is one of the SFF-8431
Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module
tests.

Signal validation

For compliance, perform BSignal Validation Procedure.

Measurement procedure

The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Dp and Dn after deskewing and applying
12 GHz filter

Algorithm

B Input differential PRBS waveform.

B On the input waveform, identify the regions with the pattern 11111111 or 00000000.
B On each such pattern, measure the mean voltage in the middle 20% of the pattern.

B The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

B The required result amplitude is given by, Amplitude = vHigh — vLow.
B End
Limits

Target value = 1000 mV
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Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.

See also

m_ QOscilloscope Setup

B Common Test Parameters and Values
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Output AC Common-Mode voltage (RMS)
(Module)

176

Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP
+ DN)+2) signal. This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input
Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests: All other Module
tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Output AC common-mode voltage (RMS) is measured using the base oscilloscope.
1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose
Histogram Vertical.

3. Select Mathl1 as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits
Maximum = 15 mV (Table 17)

Snapshot and cursor placement details

A snapshot where the histogram on math and the standard deviation value of the histogram is visible on
the screen. The standard deviation value visible on the screen should be the value reported in the report.
No cursors are required.

See also

B_ Oscilloscope Setup

®__Common Test Parameters and Values
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Total jitter (Module)

Total jitter, as used here, is the Level 1 definition for TJ as described in the FC-MJSQ, where TJ is the
crossing width, defined as the late time at which the BER is 10-12 minus the early time at which the BER
is 10-12, This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance
Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module
tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Total jitter is measured using base DPOJET.
®  Deskew the Data+ and Data- inputs. Compute the differential signal on Mathl = Dp — Dn.

®  Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single ended
input signals.

DPOJET settings
B Select Tab: Select Jitter, click TJ@BER.
- Configure the source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp — Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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Configure Tab:

Edges: Signal Type = Data
Clock Recovery:
= Method = PLL-Custom BW
= PLL Model = Type 11
= Damping = 700 m
- Loop BW =4 MHz
= Click the Advanced Button:
= Nominal Data Rate = ON Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
RjDj:
For PRBS9 signal:
= Pattern Type = Repeating
=  Window length = 511 UI
= BER 1E-=12 (for J2 BER 1E- = 2.6; for J9 BER 1E- =9.6)
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12 (for J2 BER 1E- = 2.6; for J9 BER 1E- =9.6)
Filters: No filters
General: OFF
Global:
= Gating: OFF
= Quality: OFF
- Population: OFF

Results Tab: In the Options menu, deselect Display Units — Absolute.

Click Single.
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Limits

Maximum value = 0.28 Ul

Snapshot and cursor placement details

No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom
a part of the waveform to see the type of waveform used for the measurement. Zoom the waveform
between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in the
zoomed part will be 200.

See also

B_ QOscilloscope Setup

®__Common Test Parameters and Values
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Data dependent jitter (Module)

DDJ is the range (max — min) of the timing variations measured on the differential signal with a crossing
level equal to the average value of the entire waveform being measured. The waveform is averaged
sufficiently to remove the effects of random jitter and noise in the system. This test is one of the SFF-8431
Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests : All other Module
tests.

Signal validation

For compliance, perform BSignal Validation Procedure.

Measurement procedure
Data dependent jitter is measured using base DPOJET.
B Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp — Dn

m  Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended
input signals.

DPOJET settings
m  Select Tab: select Jitter, click DDJ.
= Source configuration:
= Source = Math 1 (Chl — Chl)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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®  Configure Tab:
= Clock Recovery:
= Method = PLL-Custom BW
= PLL Model = Type 11
= Damping =700 m
= Loop BW =4 MHz
= Click the Advanced button:
= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
- Click OK.
= RjDj:
For PRBS9:
= Pattern Type = Repeating
= Pattern Length = 511 Ul
= BER 1E-=12
For PRBS31:
= Pattern Type = Arbitrary
=  Window Length = 10 UI
= Population = 100
= BER 1IE-=12
= Filters: No filters
= General: OFF
= Global:
= Gating: OFF
= Quality: OFF
= Population: OFF
m  Results Tab: In the Options menu, uncheck Display Units — Absolute.
B Click Single.

Limits

Target value = 0.10 UI
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Snapshot and cursor placement details

No cursors are required because Data Dependent Jitter cannot be shown using cursors or snapshots.
Instead, zoom a part of the waveform to see the type of waveform used for the measurement. Zoom the
waveform between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in
the zoomed part will be 200.
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Data dependent pulse width shrinkage
(Module)

DDPWS is measured as the difference between one symbol period and the minimum of all the differences
between pairs of adjacent edges on the Differential Signal with a crossing level equal to the average value
of the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of
random jitter and noise in the system. This is a SFF-8431 Revision 4.1 Table 17 Module Transmitter Input
Tolerance Signal Calibrated at B” test.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module
tests.

Signal validation

For compliance, perform®Signal Validation Procedure.

Measurement procedure

The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Data+ and Data— after deskewing.

Algorithm

®  Input differential waveform.

B Estimate the Ul of the waveform (UI = bit duration).

m  Identify all the PRBS9 patterns found in the acquired signal.

E  Overlap all the PRBS9 patterns found in the acquisition to get a single averaged PRBS9 pattern.

®  [dentify the minimum width between adjacent edges of the averaged PRBS9 pattern. [= minimum UI]

m  Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated Ul — minimum
UL

Limits
Target value = 0.055 Ul

Snapshot and cursor placement details

This measurement has one zoomed snapshot with cursorl and cursor2 marking the smallest UI.
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See also

B_QOscilloscope Setup

B Common Test Parameters and Values

184 TekExpress SFP+ QSFP+ Tx Compliance and Debug Solution



SFP+ QSFP+ Tx tests Uncorrelated jitter (Module)

Uncorrelated jitter (Module)

Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the
transmitter data. The uncorrelated jitter (rms) is given by the RMS value of the standard deviations of
the two distributions, namely standard deviation of jitter on rising edge and standard deviation of jitter
on falling edge. This test is one of the SFF-8431 Table 17 Module Transmitter Input Tolerance Signal

Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module
tests.

Signal validation

For compliance, perform ®Signal Validation Procedure.

Measurement procedure

The uncorrelated jitter measurement is performed using the algorithm library.

Inputs to algorithm
m  Differential waveform obtained on a Math channel using Data+ and Data- after deskewing

m  Signal Type ("SFPPlus.SignalType")

Algorithm
B Input differential waveform.

®  [dentify the deviation of each rising and falling edge on the input signal from its ideal location
(constructed using Ul = 1+ data rate) (Note: consider the rising and falling edges of a pattern with the
longest run of 1s to maintain some uniformity on the edges to measure deviations. If the deviations
were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

B Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the
deviation of the falling edges.

®  Compute UJ as follows:
2 2
=+(c +
Uncorrelated jitter (rms): (Gr N )/2
where o, is the standard deviation of the jitter on the rising edge
where o is the standard deviation of the jitter on the falling edge

B  End
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Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = UJ.Mean

Limits
Target value = 0.023 Ul

Snapshot and cursor placement details

No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of
the waveform to see the type of waveform used for the measurement. Zoom the waveform between time 0
and (H-scale ~ 104). If the record length is 2M, the number of points in the zoomed part will be 200.

See also

B_ Oscilloscope Setup

B Common Test Parameters and Values
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Eye mask hit ratio (Module)

The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter

eye diagram (used to measure the number of Mask Hits). Eye Mask hit ratio is computed using Eye Mask
hit ratio = (Number of Mask Hits x Signaling Speed) + (Number of Uls x Sampling rate). This test is one
of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests: All other Module
tests.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP+ QSFP+ Tx application.
The software assumes that the PRBS31 pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.
B Deskew the Data+ and Data— inputs. Compute the differential signal on Math1 = Dp — Dn.

®  Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended
input signals.

DPOJET settings
m  Select Tab: Select Eye >Mask Hits.
= Configure the Source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp—Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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®  Configure Tab:
= Edges: Signal Type = Data
= Clock Recovery:
= Method = PLL — Custom BW
= PLL Model = Type 11
= Damping =700 m
= Loop BW =4 MHz
= Click the Advanced button:
= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
= Click Apply.
- RjDj:
For PRBS9 signal:
= Pattern Type = Repeating
= Pattern Length = 511 UI
= BER 1E-=12
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12
- Filters: No filters
= General: OFF
= Global:
= QGating = OFF
= Quality = OFF
- Population = OFF
B (Click Run.

NOTE. Run until population crosses 2M.
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The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following
formula to obtain the Mask hit ratio:

Mask Hit Ratio = Number of Mask Hits x Signaling Speed (10.3125 %) + Number of Uls (Population
from DPOJET) x Sampling Rate (50 ¢9)

Limits

Mask hit ratio of 5 x 10-5

Snapshot and cursor placement details

This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.

See also

m_ Oscilloscope Setup

B Common Test Parameters and Values
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De-embed using filter files

192

TekExpress SFP+ QSFP+ Tx provides an option to de-embed the signal path using filter files. You create
the filter files. The filter files are .flt files composed of de-embed filter coefficients for a particular sampling
rate. A filter file created for one sampling rate might not work for other sampling rates, so it is important to
understand at what sampling rate the measurements are being performed. The following table summarizes
the sampling rates used for each measurement.

Table 18: Measurement sampling rates

Measurement Oscilloscope model
DPO/DSA/MSO C, D, DX, and SX Series (>16 GHz BW)
Input on Ch1 and Ch3

Single-Ended Output Voltage Range 100 GS/s

Output AC Common Mode Voltage (RMS)

Host Transmitter Jitter and Eye Mask specifications

Crosstalk Source Rise/Fall Time (20% — 80%) 100 GS/s

Crosstalk Source Amplitude (p-p differential)

Signal Rise/Fall Time (20% — 80%)

Total Jitter (p—p)

Data Dependent Jitter (p-p)

Data Dependent Pulse Width Shrinkage (p-p)

Uncorrelated Jitter (RMS)

Transmitter Qsa

Eye Mask Hit Ratio

Host Transmitter Output Specifications for CU (SFP+ Host supporting direct attached cables)

Voltage Modulation Amplitude (p-p) 100 GSI/s

Transmitter Qsa

Output AC Common Mode Voltage
Host Output TWDPc 3.3 TSIs

See also

B Common Test Parameters and Values

m_ Configure Tests
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Deskew channels

Deskew channels

If skew is present between positive and negative channels, then the channels need to be deskewed before
being used for waveform measurements. TekExpress SFP+ QSFP+ Tx provides support for channel
deskew using the following method:

1.
2.
3.

8.
9.

Determine what the skew is for each channel.
From the TekScope menu, select Vertical > Deskew.

In the Deskew/Attenuation window, click the channel (1 — 4) button for the first channel to be
deskewed.

Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or —ve.
Click the channel button for the next channel and repeat step 4.

After entering the skew for all the channels that require it, from the Options menu in TekExpress
SFP+ QSFP+ Tx, select Deskew.

In the Deskew dialog box, select the desired level:

= Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the
oscilloscope’s vertical setting is less than 100 mV/division.

= 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the
oscilloscope’s vertical setting is greater than 100 mV/division.

Click Read Deskew/Attn.

When the status in the dialog box indicates the deskew is finished, click Close.

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or
cables of different lengths. The instrument applies the delay values after each completed acquisition. The
deskew values are saved as part of the instrument setup. The deskew values for the selected channel are
retained until you change the probe, you restore a saved setup, or you recall the factory setup.

See also

B_ Select Acquisitions
B PreRun Checklist
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Map the My TekExpress folder
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Follow these steps to map the My TekExpress folder on the instrument:

1.

Eol o

Open Windows Explorer.
From the Windows Explorer menu, click Computer.
In the menu bar, select Map network drive.

Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer. Windows 7 users: if you do not see
the Tools menu, press the Alt key).

In the Folder field, enter the remote My TekExpress folder path (for example, \\192.158.97.65\
My TekExpress).

To determine the IP address of the instrument where the My TekExpress folder exists, do the following:

1. On the instrument where the My TekExpress folder exists, click Start and select Run.
2. Type “cmd” and then press Enter.

3. At the command prompt, type “ipconfig” and then press Enter.

See also

B Before You Click Start

B Install the Software
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